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Introduction 
As an introduction. some basic rules for good use of fem software are given: 

• Do not start too complex. It is better to draw up a coarse model first and to refine it afterwards. From the 
coarse model many primary conclusions can be already drawn to simplify the rest of the course of the 
modelling. 

• In many cases the Finite Element mesh is too coarse in a specific detail area to obtain exact results. 
Instead of trying to refine the mesh in such an area, it is mostly advisable to draw up a sub model of the 
detail. 

• Drawing up a sub model is based on the Saint-Venant principle that indicates that if the real force 
distribution is replaced by a static equivalent system, the stress distribution is only influenced in the 
direct environment of the point of application of the forces. More specific: this means that if the edges of 
the sub model are removed far enough from the stress concentrations that you want to examine, the 
sub model gives reliable results. 

• Restrict the structure type to the necessary. It is not always necessary to model a 3D structure. A 2D 
environment can provide just as good results in a quicker and simpler way. Especially the restriction of 
the number of degrees of freedom can lead to fewer problems with the calculation. 

• If possible, use symmetry to restrict the calculation model in size. 

• Always apply/test new functionalities or special techniques to a small project and apply it only 
afterwards on the real complex project. 

• Always calculate the structure after modelling, loaded with the self-weight. The other loads can only be 
imported when no problems are encountered. 

• Always consider the compliances of the complete construction when having an instability/singularity. If 
the degrees of freedom are obstructed for the entire structure according to the construction type, only 
then have a look at the members. 

• After calculation: 
o check if Σ(loads) equals Σ(reactions); 
o check the reaction forces; 
o check if the moment diagram progresses as expected; 
o check if the structure is deformed as expected. 

• If possible, always perform a short manual calculation to verify or estimate the order of magnitude of the 
results. 
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Chapter 1: The elements in SCIA Engineer 

1.1. Type of Element – Solver 
The solver of SCIA Engineer uses the same element for plates as for the bending behaviour of shell 
members. Analogously, the same element is used for walls and for their functioning, namely the wall inner 
forces.  

In a General XYZ environment there are 6 degrees of freedom for each node. Physically, these 6 degrees of 
freedom represent the following: the displacements u, v, w and the rotations ϕx, ϕy, ϕz. The components of 
displacement are given in the local axis of the element. So u, v and ϕz represent the plane stress/strain state. 
w, ϕx and ϕy indicate bending/shear force. 

The element used in SCIA Engineer for the calculation of membrane forces includes a 3-nodes triangle and 
a 4-nodes quadrilateral with 3 degrees of freedom per node.  

 

Regarding the application of these elements, the following advantages can be given:  
• The structure is calculated more accurately. 
• The 2D elements can be connected to the 1D elements in the nodes thanks to their rotational degree of 

freedom. 

For more information see ref. [5]. 
A detailed description of the element used for bending/shear force is given in ref. [7]. 

Because of the following properties of the solver in SCIA Engineer, an optimal result is obtained for the finite 
elements calculation (ref. [6]): 

• Implementation of the algorithm for interpolation on edges. 
This provides an accurate approach of the shear stresses on an edge. 

• Great precision concerning the calculation of internal forces in ribs. 
• Use of the model for line supports on 2D member edges: this method introduces a good representation 

of the intensity with the guarantee of continuity of the stresses on the intersections of crossing line 
supports.  

• By optimizing of the algorithms and by rewriting some parts of the code with respect to earlier versions 
(before version 5.0), there is a gain of speed of approximately 15%. 

For the bending behaviour there are 2 types of elements implemented: 
• The Mindlin element including shear force deformation 
• The Kirchhoff element without shear force deformation 

The difference between a Kirchhoff and a Mindlin calculation will be discussed in Chapter 2: 

   

 

[u2, v2, ϕ2] [u1, v1, ϕ1] [u1, v1, ϕ1] 

 

[u3, v3, ϕ3] 

[u2, v2, ϕ2] 

[u3, v3, ϕ3] 
[u4, v4, ϕ4] 
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1.2. Local axis of a 2D element 
Each 2D finite element has a local axis. The results (internal forces. stresses) are represented according to 
these axes and the loads can be introduced according to them.  

The local coordinate system can be drawn on each element: 
Set view parameters for all > Structure > Local axe s > Members 2D 

For projects with Plate XY and Wall XY , the local axis is identical to the global axis. 
The following explanation relates to General XYZ projects.  

The local coordinate system is a right-handed Cartesian coordinate system. The origin of the axis lies in the 
starting point I of the 2D mesh element. The results are independent of the choice of starting point I. The 
generator of the finite element mesh defines the begin node of each mesh element automatically.  

The z-axis is perpendicular to the plane of the 2D mesh element and the orientation is defined as follows: 

When an observer looks in the direction (resp. in opposite direction) of the z-axis, the description of the 
nodes I, J, K, L of a mesh element is clockwise (resp. counter clockwise). 

The direction of rotation of a 2D finite element corresponds to that of the 2D member to which the finite 
element belongs. The direction of rotation of a 2D member depends on the direction in which the nodes are 
established while introducing the geometry.  

You can modify the direction of the local z-axis after input of the geometry. This can be useful to simplify the 
input of the loads. Select the 2D member and check the option LCS Z axis Swap orientation. Pay attention 
to the local axes of the mesh elements, that they will not rotate with this option. 

The local x- and y-axes are located in the reference plane of the 2D mesh element (the middle plane) and 
since the coordinate system is always orthogonal, it is sufficient to define the local x-axis: 

The local x-axis is the intersection curve of a horizontal surface through the origin of the global axis and the 
surface of the 2D mesh element. Its positive orientation is defined in such a way that the angle between the 
+x and +X-axis is acute. 

There are two cases for which above-mentioned definition is inadequate: 
1. If the local x-axis is perpendicular to the X-axis, the criterion of the acute angle is not valid anymore. 
2. When the element plane and the XY surface are parallel, a cross-section cannot be defined. 

The rule for the definition of the local x-axis in case of these exceptions is as follows: 

1. The orientation of the local +x-axis corresponds to the orientation of the +Y-axis. This criterion replaces 
the criterion of the acute angle. 

2. The +x and +X axes are identical.  
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Example: 01_01_Axis.esa 

In this example, a sloping plate is introduced as a shell element to indicate the position of the local axis 
according to the above-mentioned rules.  

The numeration of the nodes is given clockwise when you look in the direction of the local z-axis.  

The intersection line of a horizontal plane through the origin with the plane of the 2D member represents a 
straight line according to line K1 and K2. This means that the local x-axis is perpendicular to the global X-
axis so the criterion of the acute angle is not valid. As a result, the orientation of the local +x-axis 
corresponds to the orientation of the +Y-axis. 

 

Since version SCIA Engineer 2011 you have the possibility to set the direction of the local system axis in 
following ways: 

0. x(y) automatic (same as in SCIA Engineer 2010.1) 
1. x(y) parallel to a given plane 
2. x(y) concurrent with a given line. 
It leads from the center of the element to the cross of the element plane and the line. 
3. x(y) as a tilt of a vector defined by a vector. 
It is a vector, lying in the element plane, which has the smallest angle with the given vector) 
4. x(y) as a tilt of a vector defined by a given point. 
It is a vector, oriented from the element center to the given point, will be tilted to the element plane. 
5. x(y) as a tilt of a vector defined by a given line. 
It is a vector, starting at the element center and perpendicular to the given line will be tilted to the 
element plane. 

You can interact and swap the local z direction on all 6 methods. 

Points and vectors required to define the new types of local system axis are set by the user in the properties 
of the 2D member. 

• The local system of the type 1 and 3 is defined by one vector. 
• The local system of type 4 is defined by one point. 
• The local system of the type 2 and 5 is defined by two points. 

  



Advanced Concept Training – FEM Analysis  

10  TC – 2023/09/11 

Example: 01_02_User defined LCS.esa 

In this example the use of a user defined LCS with local x-axis pointing to a given point is illustrated. 
There are two cones. The cone at the left has standard definition of local axis. On the other cone, the LCS is 
defined by a tilt of a vector defined by the top of the cone. 
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Chapter 2: Mesh Generation 

2.1. Mesh Settings 
Under Tools > Calculation & Mesh > Mesh settings the size of the mesh elements and the general setup 
of the mesh generator can be changed. The mesh settings here will be applied on the entire project, unless 
local mesh refinements are applied. 

The local mesh refinements can be added in the input panel under Calculation & Results and in category 
Local mesh refinement. These refinements can be introduced on a specific node. 2D member edge or on a 
surface. That way for example, a coarse distribution can be adopted on the global structure and a more 
refined mesh for a specific 2D element. 

General setup with Tools > Calculation & Mesh > Mesh settings: 

 

Average number of tiles of 1D element  
If necessary, more than one finite element may be generated on a single beam. 
The value here specifies how many finite elements should be created on the beam.  

The value is taken into account only if the original 1D member is longer than adjusted minimal length of 
beam element and shorter than adjusted maximal length of beam element . 

Average size of 1D mesh element on curved 1D member s [m]   
The average size of 1D mesh element on curved 1D members not connected to 2D members. 

Average size of 2D element/curved element [m] 
The average size of an edge of a 2D element. This size may be changing when refining the mesh in 
specified points.  

Connect members/nodes 
Possibility to automatically connect 1D and 2D members before calculation. As default for new projects it is 
ON, for old projects it is OFF. 
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General mesh settings 

Minimal distance between two points [m] 
If the distance between two mesh nodes is less than the value specified here, then these two points are 
automatically merged into one single point. This option applies for both 1D and 2D elements. 

Definition of mesh element size for panels 
If the mesh size for load panels is set to Automatic, then SCIA Engineer will use a mesh size of 1 meter. If 
this value is set to Manual, then you can specify the average mesh size in the next field. 

Average size of panel elements [m] 
Defines the average size of mesh elements for load panels (when the definition is set to manual). 

Elastic mesh 
If ON mesh on 2D members is generated much variable than in previous versions. It also allows to use 
automatic mesh refinement functionality. 

Use automatic mesh refinement 
If ON mesh on 2D members can be refined automatically in places where is necessary for better results. 

1D Elements 

Minimal length of beam element [m] 
A 1D element cannot become shorter than this value. This value supersedes the parameter above (Average 
number of tiles of 1D element) . 

Maximal length of beam element [m] 
A 1D element cannot become longer that this value. If a beam of the structure is longer than this value, then 
this beam will be divided into multiple mesh elements to satisfy the condition of maximal length.  

Average size of cables. tendons. elements on subsoi l. nonlinear soil springs 
To obtain precise results, it is necessary to generate a sufficient dense element mesh on cables, tendons 
(prestressed concrete), 1D elements on subsoil and when using nonlinear soil springs on 1D elements. 

Generation of nodes in connections of beam elements  
If this option is ON, a check for "touching" beams/FE node and FE node/FE node is performed. 
This means:  

• if a FE node of one beam "touches" another beam in a point where there is no node, then the two 
beams are connected by a FE node. 

• If an FE node of one beam coincides with an FE node of another beam, then these 2 FE nodes become 
1 FE nodes, thus connecting both beams 

If the option is OFF, such a situation remains unsolved and the beams are not connected to each other. 
The function has the same effect as performing the function Check of data . 

Be aware: when you mesh 2 wind bracings with an even number of tiles, then they will automatically connect 
because they will have a common FE node. It is always recommended to use an odd number of tiles when 
meshing 1D members. 

Generation of eccentric elements on members with va riable height 
If a beam is of variable height, the generator automatically generates eccentric finite elements along the 
haunch. 
Moreover, if this option is ON. the eccentricity of the elements may vary along the element, i.e. the start-node 
of the element may have different eccentricity than the end-node of the element. 
If this option is off, the eccentricity along individual finite elements is constant and the eccentricity changes in 
steps in nodes along the haunch. 

Division on haunches and arbitrary members 
This specifies the number of mesh elements generated on a haunch. This option prescribes the precision of 
the modelling. The larger the number, the better the model approaches the reality. 

Division for 2D-1D upgrade 
This specifies the number of mesh elements generated on the (resulting) 1D member when doing a 2D-1D 
upgrade. 
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Mesh refinement following the beam type  
This specifies if the nodal mesh refinements should also be applied to beam members. 
The nodal mesh refinement is represented by a volumetric sphere. As a consequent, the mesh of all the 
structure elements situated in this sphere will be refined taking the following possibilities into account: 
None 
The refinement is not applied to 1D members (so. it will only be applied to 2D members). 
Beams and Columns 
The refinement is applied only to 1D members with Type set to ‘Beam (80)’ or ‘Column (100)’. 
All members 
The refinement is applied to all 1D members 

2D elements 

Maximal out of plane angle of a quadrilateral eleme nt 
This value determines whether a spatial quadrilateral element whose nodes are not in one plane will be 
replaced by two triangular elements. This parameter is only meaningful for out-of-plane surfaces – shells. 
The assessed angle is measured between the plane made by the first three nodes of the quadrilateral and 
the remaining node of this quadrilateral. 

Predefined mesh ratio 
Defines the relative distance between the predefined mesh formed by regular quadrilateral elements and the 
nearest edge. The edge may consist of an internal edge, external edge or border of refined area. The final 
distance is calculated as a multiple of the defined ratio and adjusted average element size for 2D elements. 

Shape of mesh elements 
Three different configurations are possible for the shape of mesh elements for 2D members: 
Quadrangles and triangles 
Quadrangles only 
Triangles only 

2.2. Mesh Size 
The correct mesh size is a vague concept. A finer mesh gives better results in general, but in case of 
singularities or peak values, a finer mesh makes these peaks much worse. 

In SCIA Engineer, the results on plates are by default already post-processed. This means that you see 
results that are a bit brushed up. 

The mesh size for 2D elements will be evaluated for the next project. 

  



Advanced Concept Training – FEM Analysis  

14  TC – 2023/09/11 

Example: 02_01_Mesh_size_2D.esa 

Model 

 

The project starts with a mesh size of 1m for the 2D elements. 

 

The loads in the project consist of only the self weight. 

Results 

The linear calculation is performed. When looking at the internal forces on the 2D element. the following 
results can be shown (under Results  2D members  internal forces   mx) 

 
As mentioned before, these results are post-processed. The post-processing configuration can be seen in 
the property ‘location’ . 
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There are 4 choices for ‘location’. More details can be found in section “5.1 Convention of terminology and 
sign of the results”. 

 

It is clear that the results of the option ‘In nodes, no avg.’  must be investigated. 
We use a fixed palette so to have a better comparison of results. 

 

The results are not alike, which means that the post-processing has quite a big impact on the representation 
of results. This indicates that the mesh is not fine enough. 

Solution 

A rule of thumb for concrete plates is to take a mesh size equal to 1 or 2 times the thickness of the plate. In 
this project that would be 1 or 2 times 0.2 m for the wall and 0.3 m for the plate.  
Let’s take a mesh size of 0.25 m.  
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The unprocessed results now look like this: 

 

While the processed results look like this: 

 

The results with or without post-processing have a very similar presentation of results. This indicates that the 
mesh is fine enough. 

Example: 02_02_Subsoil.esa 

Model 

In this example a HEA200 with steel quality S235 is calculated according to the EC. The beam has a length 
of 10 m and is supported by means of a foundation strip with a stiffness of 50MN/ m². At the ends and in the 
middle the beam is loaded by point forces of 50 kN. 

Results 

Successively, the number of elements of a beam on subsoil has increased to evaluate the influence of the 
mesh refinement on the results. The results are considered in the middle of the beam.  

Average Size [m]  # 1D Elements  Uz [mm]  My [kNm]  
10 2 -0.20 -0.18 
5 4 -0.37 2.37 
1 12 -0.62 8.76 

0.5 22 -0.64 10.19 
0.25 42 -0.64 10.65 
0.1 102 -0.65 10.79 

 
It shows clearly that a mesh refinement has a significant influence on the results.  
In this case, it is important to realize that a standard mesh, satisfactory for normal beams, is insufficient for 
beams on a subsoil. For this reason, SCIA Engineer allows to refine the mesh particularly for this type of 
beams. 
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Example: 02_03_Haunch.esa 

Model 

A haunch imagines a structural element with a variable height. However, a 1D mesh element has a constant 
height. Because of this, it is necessary to design these beams with a variable height by means of a finer 
mesh. 

In this example a haunch with a length of half the beam is considered. This beam has a width of 100 mm, a 
length of 4 m and concrete quality C25/30 according to the EC. The height of the haunch varies between 
1000 mm and 200 mm. The whole is loaded in the middle by a point force of 250 kN. 

Results 

If for example the number of finite elements per haunch is chosen as 2, then the haunch is divided into two 
segments during the mesh generation. Subsequently the section in the middle of each segment is 
determined. This segment will be used for the finite element. 

 

The number of finite elements per haunch is increased and the influence on the global maximal deflection of 
the beam is analyzed: 

# FE per haunch  Uz [mm]  
2 -45.89 
5 -48.40 
10 -49.69 
20 -50.15 
50 -50.29 

 
The results show that a higher number of elements will approach the real haunch better. On the other hand, 
the number of elements is not directly in proportion to the precision. This example shows also that using 
about 10 mesh elements is already sufficient to receive an accurate result. 
So, it is not necessary to use an extremely high number of elements.  
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2.3. Elastic Mesh 

Example: 02_04_Elastic_mesh.esa 
In the project “Mesh_Elastic.esa” we are going to show the effect of using an elastic mesh. 

Model 

The model has the dimensions shown in the image below.  
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Results 

First the mesh is generated without the elastic mesh. This can be set in the mesh settings: 

 

The global mesh setting is 0.2 m. 

The mesh can be generated by using Tools > Calculation & Mesh > Generate Mesh  

The mesh can be displayed by the view parameters. These can in the graphical display bar under View 
settings for all entities  > Structure > Mesh > Dra w mesh.  

The elastic mesh in the mesh setup provides a fluent transition between mesh sizes. 

Elastic mesh on (default setting):  

 

Elastic mesh off: 

 
 

2.4. Automatic mesh refinement 
SCIA Engineer offers a feature called Automatic mesh refinement. A fine mesh of finite elements produces 
more accurate results than a coarse mesh. But to find the correct fine mesh is sometimes a very hard task 
for a user. Therefore, we developed a solution for automatic mesh refinement which reflects state of the art 
error estimation methods. The benefit of the method is also that information is given about the quality of 
results due to the used mesh density of two-dimensional mesh elements. 
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Example: 02_05_Mesh_Automatic.esa 

Model 

The model is composed of a ground and top floor, separated by multiple columns. 

 

Results 

As indicated in the example about mesh refinements, the mesh can be judged by going to a 2D result, and 
setting the ‘Location’  to ‘In nodes, no avg.’ . In the image below, the moment mx has been asked for the 
self weight. 

 
The mesh is certainly not good enough. You can see that there are incoherent results and peak values near 
the columns. 
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Solution 

Now we will perform an automatic mesh refinement based on the results for the self weight. 
To perform the automatic mesh refinement, the next steps are required. 

1. Activate the automatic mesh refinement. 
a. Go to the mesh settings. 
b. Activate both elastic mesh and automatic mesh refinement. 
c. Choose the load case and the target error for the mesh refinement. 

 

2. Perform the linear calculation. You will also receive information about the error estimation for the load 
case configured in the previous step. 

 

3. If desired, you can check the numerical error under results > 2D members > Numerical  Error & 
mesh refinement. 

 

4. To perform the automatic mesh refinement, you must manually click on the mesh generation. This 
option can be found under Tools > Calculation & mesh.  
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5. Now perform the linear calculation again. The estimated error will have reduced, since the mesh has 
been refined. 

 

6. To go even further in the mesh refinement, run through steps 4 and 5 until the desired result is 
achieved. 

After just 1 mesh refinement, the mesh is now locally refined. 

 

The unprocessed result for mx also shows less jumps. 

 

To improve the results, we advise to also add averaging strips. This is treated in the chapter about 
singularities. 
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2.5. Warning : Elements with angle < 5° 
If there are mesh elements with an angle < 5° the program gives a warning during the mesh generation with 
the numbers of these elements. These elements give inaccurate results. Usually, it is about an error in the 
geometry input. The inaccuracy of results reveals itself in the neighborhood of this mesh element. Therefore, 
it is suitable to correct them, for instance by local mesh refinement. 

 

To track these mesh elements, view flags will point to these mesh elements with angle < 5° and they give the 
name of the 2D element to which these mesh elements belong. Flags can be activated via right clicking in 
the graphical scene and choosing View settings for all entities > Misc. > Calculatio n info > Display 
arrow on small mesh elements.  
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2.6. Display of Mesh nodes and Mesh elements 
The labels of the mesh nodes, 1D and 2D elements can be displayed via View Settings for all entities > 
Labels > Mesh . This makes it possible to recover the elements of the above-mentioned warning or to have a 
look at the results in a specific node of the deformed mesh. 

 

 

Further, this option also allows verifying for example the number of 1D elements on a beam.  

 

Representing these labels is only possible after generating the Finite Elements mesh. 
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Chapter 3: Distribution of the loads 
The solver of SCIA Engineer knows 3 types of loads on the finite element mesh: 

• a constant surface load on a 2D element. 
This load works according to a local axis of the element, or according to the global axis 

• a point force in a node of the element mesh 
• a point moment in a node of the element mesh 

The loads that are inputted in SCIA Engineer, are recalculated to loads on the finite element mesh as 
follows: 

Introduced load Is converted to: 

2D surface load Surface load on 2D elements 

Free load – Rectangular or polygon  Surface load on 2D elements; those are located 
completely into the charged surface. If 2D elements 
are charged partially. this load is converted into point 
forces on the nodes. The load on each 2D element is 
constant. A linear load is translated in a load that 
goes off gradually.   

Free load – Line load or point force  Point forces on nodes 

Free load – Point force (moment) Point moments on nodes 

1D line force or 1D point force Point forces on nodes 

1D line force or 1D point moment  Point moments on nodes 

 

A point force is translated into forces on nodes of the mesh – without moments. The error created by this is 
generally smaller than the error caused by a finite division in elements. The error converges to zero when 
refining the mesh.  

After the calculation, the loads on the finite element mesh can be looked at via Results > surface loads.  

For larger projects, it is not necessary to calculate the entire structure in order to examine the division of the 
loads: start the calculation and choose the option Test input of data instead of Linear analysis in the 
dialogue box for the calculation. The loads are spread over the mesh, but the structure is not calculated. 
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Chapter 4: Calculation – Solution Methods 
During the calculation, the solver has to formulate and solve the following system of equations: 

F = K . ∆ 

In this equation, F represents the force matrix, K the stiffness matrix of the structure and ∆ the displacement 
matrix. For large projects, this involves a system that solves tens of thousands of equations (e.g. 40.000 
nodes = 240.000 degrees of freedom = 240.000 equations).  

To solve this system, two solution methods have been implemented in SCIA Engineer: the Direct Solution 
and the Iterative Solution. 

4.1. Direct Solver 
This is a standard Cholesky solution. based on a decomposition of the matrix of the system. Using this 
method, the system is solved directly into the displacements.  

The advantage of this method consists of several right sides that can be solved simultaneously. This means 
that all linear load cases can be solved collectively. This type of solution is especially effective for little and 
medium-sized problems. The limit depends on the size of the problem and consequently the size of the 
available RAM memory. 

Generally, it can be said that this solution is more convenient for most of the problems.  

The disadvantage of this solution may emerge with extremely large projects. The calculation time may rise 
considerably when the RAM size is unsatisfactory. What’s more, the problem cannot be solved at all when 
the available disk space (for memory swapping) is inadequate.  

If the problem is big and of poor numerical condition, the rounding error may be so big that it exceeds the 
acceptable limit. This may result in an imbalance between results of load and reactions. The difference 
between the total sums of loads and reactions should not be bigger than about 0.5%. But even a value of 
0.1% suggests that the results may be suspicious. 

The total action and reaction per load case can be found in the Calculation protocol under Results. 

If this imbalance appears, the program gives a warning and you should choose the iterative solver. A precise 
value of the number of elements in a project which would lead to this problem cannot be defined, because 
the rounding errors also depends greatly on the ratio of the stiffnesses of the elements.  

4.2. Iterative Solver 
The Incomplete Cholesky conjugate gradient method is applied. With this method, an assumed value for the 
displacements is introduced in the system. Subsequently the forces F are calculated and compared to the 
inputted forces. From this, new displacements are deduced. In that way, the displacements are calculated 
iteratively. 

The advantage is a minimal demand on RAM and disk size (a project with 150.000 nodes requires about 250 
MB RAM memory). Therefore, the solution is convenient especially for extremely large projects that cannot 
be solved by means of direct solution or whose calculation time would be enormous for that kind of solution 
due to excessive disk operations.  

Another advantage is that due to the ability of continuous improvement of the accuracy, the method is able to 
find a technically accurate solution even for equation systems that would be numerically unstable in the 
direct solution. 

The disadvantage is that the method can only employ one right side at a time and this increases the time 
demands for equation systems with several right sides. 

The desired solution method can be established under Tools > Calculation & Mesh > Solver settings 
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Chapter 5: Results 

5.1. Convention of terminology and sign of the resu lts 

The following internal forces are given in relation to the finite elements. The indicated directions of the 
internal forces declare the positive directions. The action on the 2D mesh elements is drawn.  

For bending (2D plates. 3D shells) : 

Bending moments mx . my 

 

In case of homogeneous plates. the stress on the positive side z = +h/2 is: 

              σx = -mx / W. σy = -my / W. with  W = h2 / 6. 

Torsional moment mxy 

 

In case of homogeneous plates. the stress on the positive side z = +h/2 is: 

σxy = -mxy / W.   with W = h2 / 6. 
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Shear forces qx. qy 

 

The vertical components of shear stress are τxz = -qx / h, τyz = -qy / h, constant across the thickness 
(Mindlin). More general, they can be understood as mean values for the interval -h/2 < z < h/2. 

 

For membrane effects (2D walls. 3D shells) :  

Membrane forces nx. ny 

 

The normal forces are σx = nx / h.  σy = ny / h. 

Shear forces qxy 

 

The horizontal component of the shear stress is τxy = qxy / h. 
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5.2. Comparison between a membrane and a standard e lement 
When you compare a membrane element with a general 2D-element, then you can conclude that the 
bending moment mx equals 0 in this structure.  
The figure below represents the stress σx in both elements. 

 

A plate element that is modeled in Plate XY environment will only take bending forces.  
A wall element that is modeled in Wall XY environment will only take membrane forces. 

It is however important to note that every 2D element that is modeled in a General XYZ environment can 
take both bending and membrane effects. This means not only shell elements, but also plate and wall 
elements modeled in General XYZ can take both bending and membrane effects. Unless of course it is 
defined as a membrane element, because then the elements have only axial stiffness and will therefore take 
only membrane forces. 

To define an element as a membrane element a nonlinear analysis should be run. 

Also, the module ‘Cables & Membranes’ is needed. 

By making use of membrane elements, it is possible to neglect bending effects. 

LCS mesh element and LCS-Member 2D 

The x and y axes in which the internal forces are defined, as drawn above, may be the local axes of the 
mesh element (LCS mesh element option) or the local axis of the 2D element (LCS-Member 2D option).  
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5.3. Detailed results in mesh node 
The internal forces of 2D-elements can be claimed for each mesh node or element. This is illustrated through 
following example.  

Example: 05_01_Results_mesh.esa 

A plate supported on two edges is loaded by its self weight and a permanent surface load. Out of these two 
load cases an ULS and SLS combination are generated. Subsequently, the mesh is activated and by way of 
View parameters for all entities > labels > mesh the numbering of the mesh elements and the mesh 
nodes are displayed graphically.  

 

Then the values for mx and the ULS-combination are claimed by means of Results > 2D members > 
internal forces.  

 

When drawing the results for a combination or Result class, then the property Envelope (for 2D drawing)  
should be set. 

Since combinations are normally generated in SCIA Engineer, this means that one combination definition 
contains the results of all generated combinations. 

The value “Minimum” will show the minimum values of these generated combinations. 

The value “Maximum” will show the maximum values of these generated combinations. 

The value “Absolute extreme” will show the value max [ abs (minimum value), abs (maximum value) ]. 
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5.4. Results in elements and mesh nodes 
After a calculation of the structure, the deformation of the nodes and the reactions are calculated exactly 
(displacement method). These are represented in the menu Results > 2D Members > Deformations and 
Results > Supports > Reactions.  

Deformations of nodes and reactions are the most accurate. The internal forces (and stresses) are derived 
from these quantities by means of the adopted basic functions and are always less accurate using the Finite 
Elements Method.  

The internal forces of 2D elements are given in the menu Results > 2D Members > Internal forces. Here 
are 4 possibilities:  

• In centers 
• In nodes no avg. 
• In nodes avg.  
• In nodes avg. on macro  

In centers 

The average of the results, calculated in the four nodes of the quadrilateral finite element, is shown in the 
center of gravity of the element.  

There is just 1 result per element, so the picture with isobands is a ‘mosaic’. The development in a section is 
multi-stage curve.  

 

In nodes no avg. 

The result value in four nodes of the quadrilateral finite element is considered. The distribution of a particular 
result quantity is considered linear over the element. No averaging between adjacent finite elements is 
performed. This provides that the four values of the adjacent elements are shown in a node.  

If these 4 results differ considerably, this indicates that the applied mesh is too coarse. In such cases, a 
mesh refinement should be applied on those positions. This reproduction of the results gives a good idea of 
the discretization error in the calculation model. 
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In nodes avg 

Like the option above, but the result values from adjacent finite elements are averaged to smooth the 
distribution of the result from one element to another. 

In some cases, it is not allowed to take the mean value of the internal forces in a node: 
• 3D shells if the local x and y-axes of the 2 members do not coincide. 
• If a result is discontinuous, for example the shear force at the line support of a plate: the peaks 

disappear completely when averaging the positive and negative shear forces. 

 

In nodes avg on macro 

Like above, but the average is performed only for the elements of the same slab. On the connection of two 
slabs, the results from different slabs are NOT averaged. This solves the problems mentioned above.  
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Example: 05_02_Results.esa 

Model 

In this example, a plate of 5 m x 5 m with fixed translation in Z-direction for the 4 edges is calculated. The 
plate is made of concrete C25/30 according to EC, with a thickness of 100 mm and loaded by a point force of 
100 kN in the middle.  

Results in Nodes no avg. 

The solver internally calculates the internal forces in integration points and at the end the calculated values 
are extrapolated from the integration points to the nodes of the 2D element using the formulas for a 
hyperbolic paraboloid. 

Results in Centers 

The result in the center of the mesh element is the (simple) average of the results in nodes no avg. of all 
nodes of this element. 

For mesh element 60: 

       
                                                    Nodes no avg.                             Center 

Results in Nodes avg. / Nodes avg. on macro 

The averaged results of the moments are determined by first averaging and then smoothening. 

The other averaged results are determined by only averaging. 

While the values of moments in the integration points correspond to the theory, their extrapolation to nodes 
using the hyperbolic paraboloid leads to some loss of accuracy. The reason is that the hyperbolic paraboloid 
does not replace the distribution of the moments over the element with a satisfactory precision. 

The calculation of the values of moments in nodes in SCIA Engineer uses an improved algorithm that 
replaces the hyperbolic paraboloid extrapolation with an advanced shear-force-integral method. As the 
distribution of shear forces over the surface of the element is assumed to follow the shape of the hyperbolic 
paraboloid (second order surface), the integral of this surface represents a third order surface that 
approximates the moment distribution with a higher accuracy. This is based on the formulas for the 
calculation of shear forces using the derivative of moments. 

Moments are then written from these formulas: 
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Integration constants mx,0 and my,0 are calculated from the condition of the value in the center of the element 

 

With S the area of the finite element. 

See also: Smoothening of non-averaged values 

Example 05_03_Average1.esa 

Model 

In this example, a steel structure consisting of 2 plates of 5x5 m with thickness of 50 mm is considered. The 
plates are made of S235 according to EC and are fixed along two edges. The horizontal plate is loaded by a 
line load of 2 kN/m.  

The structure is calculated with a mesh size of 1 m and the results for my are claimed according to System 
LCS – Member 2D. 

Results in Nodes Avg. versus in Nodes Avg. on macro . 
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Concerning the plates S1 and S2, the local x and y-axes have the same direction. Also the orientation of the 
local z-axis corresponds. The maximal moment in the section of the vertical plate In nodes, avg. is 3.08 
kNm/m . 

For the plates S3 and S4, the local x and y-axes correspond. But in this case, the orientation of the local z-
axis does not correspond. On the edge, the average of 2 equal moments with an opposite sign is taken. The 
result is zero. The maximal moment in the section of the vertical plate in nodes, avg. is 2.48 kNm/m. 
The result In nodes, avg. macro gives 3.33 kNm/m . 

For plates S5 and S6, the y-axis of plate S6 corresponds to the x-axis of plate S5. On the edge, the average 
of mx and my is taken, which has no significance. The maximal moment in the section of the vertical plate in 
nodes, avg. is 6.78 kNm/m . The result In nodes, avg. on macro gives the correct value of 3.33 kNm/m. 

 
In nodes avg. 

 
In nodes avg. on macro 
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Example: 05_04_Averag2.esa 

Model 

A plate consisting of 2 fields of 7 m x 4 m (total 14 m x 4 m) and supported on its 3 shortest edges. Concrete 
quality C30/37 according to EC and a thickness 200 mm. The plate is loaded by a uniform surface load of –
50 kN/m². The average mesh size amounts to 0.5 m and no averaging strips are used.  

Results 

The results are claimed for the maximal shear force vx according to the carrying axle on a section in the 
middle of the plate. 

In centers : 203.41 kN/m 

 

In nodes, no avg. : 203.6 kN/m 

 

In nodes, averaging : 191.54 kN/m 

 

The average of the positive and negative shear force is taken on the edge. 
Subsequently the result is zero so a lower maximal is obtained. 

In nodes, averaging on macro : 215.66 kN/m 
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5.5. Averaging strip 
This functionality provides for automatic averaging of peak results around defined points or along defined 
line strips on slabs. The averaging can be applied to internal forces on slabs and to required reinforcement 
areas used in the design of reinforcement in concrete slabs. This is illustrated in the following example. 

Example: 05_05_AveragingStrips.esa 

Model 

A square slab is inputted with dimensions 2 m x 2 m. The mesh size is set to 0.5 m and a surface load of  
5 kN/m² is inserted.  

 

After the calculation, the following results for mx in nodes not averaged are obtained: 
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An averaging strip can be imputed via Input Panel > Calculation & Results > Result tools > Averaging strip. 
We choose the Y-direction with “Direction” set to “Perpendicular” and a width of “1m”: 

 

Results 

If we now activate the averaging of peak, we get these results for mx in nodes not averaged: 

 

When you look at the results, drawn with numbers, a manual verification can be made: 
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For the same X-coordinate, in each element the same value will be obtained. Looking at the results in 
numbers without the averaging strip, the same value can be calculated taking the average of one line with 
the same X-coordinate: 

 

0.09 � 0.43 � 0.44 � 0.37 � 0.36 � 0.40 � 0.92 � 0.36 

8
 �0.18875 � �0.19 

This averaging strip was defined as “Perpendicular” and inputted in the Y-direction. Looking at mx 
(perpendicular to the Y-direction) an average will be made. 

When we look at my (parallel with the Y-direction) no average will be made: 

 

  



Chapter 5: Results 

TC – 2023/09/11  41 

When changing this average strip from perpendicular to longitudinal: 

 

An average will be made for my but not anymore for mx: 

    
mx. average longitudinal                                  my. average longitudinal 

When choosing “Direction” as “Both” an average will be made for the two directions. 

Note: 
The averaging algorithm uses only the finite elements that are located inside the averaging strip. This may 
cause certain inaccuracies especially in combination with larger finite elements. Therefore, it is 
recommended to define internal edges along the averaging strips. This ensures that finite element nodes are 
generated along the edge of the averaging strip, which may significantly improve the accuracy. 

The recommended procedure is thus: 
• Define the model of the structure; 
• Perform the calculation; 
• Review the results; 
• Define averaging strips; 
• Review the averaged results; 
• Decide the final location and number of averaging strips; 
• Define internal edges along the averaging strips. 

Repeat the calculation to obtain the improved results. 
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5.6. Eccentric elements 

Example: 05_06_eccentric column.esa 

Model 

In this example the effect of eccentricities is shown through a simple frame in a frame XZ environment: 
• The columns are 3 m high; 
• The beam is 4 m long; 
• All elements have a cross-section of 300 mm x 300 mm  (made of C25/30); 
• A line load of 5 kN/m  is applied on the beam. 

 

An eccentricity can be introduced on 2 ways: 
• By changing the “Member system line at” option. 
• By introducing a value for ey and/or ez. 

It is not surprising that several possibilities have the same effect. 

For example, we set “Member system-line at” “bottom”, which would be the same as inputting ez = 150mm 
(height cross-section divided by 2). 

So for this example:  

=  
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Results 

When looking at the moment diagram, we can notice some odd results: 
• The results are non-symmetrical; 
• The moment at the bottom of the left column is not zero, although the support is hinged; 
• The moment at the top of the left column is not equal to the moment on the left of the beam. 

 

When looking at the normal forces, there is nothing strange at all. Both columns take 10 kN compression 
force of the line load of 5 kN/m over the 4m long beam. 

 

The increased moment on the left column is due to the eccentricity which has been applied. 

The additional moment can be calculated as: 
∆��  � ∗ ��  �10�� ∗ 0.15�  �1.5 ��� 

This explains the moment of –5.56 kNm: 
��  ��,������ � !� � � ∗ �"  �4.06 ��� � #�10��$ ∗ 0.15�   �4.06 ��� � 1.5 ���   �5.56��� 
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Interpretation 

Why do we add the extra moment? 
• In SCIA Engineer, the results are always shown for the neutral axis of the element. 
• The connections between elements, supports, etc. are made in nodes, as required in a finite element 

model. The nodes are always at the ends of the system lines. 
• So if an eccentricity is applied, the neutral axis will no longer be the same as the system line. 

The recalculation of internal forces from the system line towards the neutral axis is what causes the jump in 
the moment line (from -4.06 kNm to -5.56 kNm). 

This is also represented in the image below.  
• The first column on the left is the same as you can see it in SCIA Engineer (the light blue line is added, 

representing the neutral line). 
• But in fact, you should represent an eccentric element as if the eccentricity is applied by small horizontal 

elements. This is represented in the middle image. 
• When you look at the internal forces of an element, these internal forces are always applied to the 

neutral line of the specific element. In this case, it implies that the forces in the nodes (coming from the 
beam and support) should be recalculated to the blue line. The recalculation is added to the third image 
(on the right). 

 
The same principle can also be shown by creating small stiff beams. 
To do this, we have used a cross-section 3000x3000 (=’very high stiffness’), which we have converted to a 
numerical cross-section. 
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Example 05_07: Eccentric beam.esa 

Model 

In this example, the effect on normal forces due to eccentricities is discussed. For this, we have constructed 
a simple beam in a frame XZ environment: 

• The beam is 6 m long; 
• All elements have a cross-section of 500 mm x 300 mm  (made of C25/30) 
• A line load of 10 kN/m  is applied on the beam; 
• The eccentricity is inputted with “member system-line at”: “bottom”  (or ez = 150 mm). 

 

As you can see, the line load is inputted on the beam and follows the eccentricity of the beam. 

The supports are in the nodes, which are positioned eccentrically from the neutral line of the beam. 

Results 

In the results, you might notice some results which you intuitively would not expect: 
• There is a normal force (although only a line load perpendicular to the beam was applied). 
• The begin and end moments are not zero, although the supports are hinged. 
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Interpretation 

First let’s run over the effect of bending without the eccentricity involved. 
 
No eccentricity 
 
The results in SCIA Engineer for this same case (without eccentricity) would be: 

 
 

• The top fibres are in compression due to the bending stress. So they also become shorter. 

%&�!' !( 
�� ∗ )

*
 + ∗ , 

• Due to a line load of 10kN/m over a length of 6m, the maximal moment would be: 

��,�-. 
/ ∗ 01

8


�10 ∗ #6 $1

8


�360 

8
 �45 ��� 

 
You can see this corresponds perfectly with the result shown above.  
The difference in sign is merely a difference in convention used by SCIA Engineer. 

• Due to this moment, the top fibre is compressed and will become shorter. 

 

• The bending stress is zero in the middle of the beam (= the neutral axis). 

• The bottom fibres are in tension due to the bending stress. They would become longer. 
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With eccentricity 
 
Due to the eccentricity, the supports  are at the position of the bottom fibres  (in the circles in the next 
image). These bottom fibres would normally become longer due to bending, but the supports do not allow 
these displacements.  

 
As a result, the supports force the elongation at the bottom fibre to be zero by means of a reaction force. 
This can also be seen in the results. 

• The reaction force 2. from the supports introduces a normal force in the beam. 
This is a constant normal force of -90 kN over the beam. 

• Due to this reaction force, there will be no elongation at the bottom fibre. 

• And due to this reaction force at an eccentricity  ��, the moment line is shifted. 
Δ�  � ∗ ��  �90 ∗ 0.25 �  �22.5 ��� 

 
This causes the moments at the begin points to be -22.5 kNm and the maximal moment to be shifted up from 
45 kNm to 22.5 kNm. 
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Chapter 6: Torsion – connection between plate and c olumn 
If a 1D member is connected to a 2D member in a single node, this can introduce problems. 

The 2D element will not be able to transfer all forces from the 1D element in just the node. 
• Peak results will appear in the 2D element. 
• The connecting node will seem to be partly hinged. 

Thus, when a structure consists of a plate with a column on top of it, you should pay extra attention to this 
when there is a question of torsion.  

If the plate is subject to forces or moments, which cause torsion, very large deformations may occur. The 
reason for this is the lack of a degree of freedom in SCIA Engineer, namely the rotation around the z-axis. 
In other words, the moment mz is not present when asking for the internal forces of a 2D element. 

The solution for this matter is the application of ‘dummy-members’ at the location of the connection between 
column and plate.  

This is clarified with the following example. 

Example: 06_01_Column_plate.esa 

Model 

Column with a dimension of 500x500 mm and a length of 4 m are attached to a plate of 4x4 m with a 
thickness of 500 mm. 

As load case, two point forces of respectively –1 kN and 1 kN are applied on the edge nodes of the plate. 
These forces are lying according to the global X-axis. In this way, the plate will be subjected to a rotation in 
its own surface without any transformation of the geometry.  
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Results 

When the value U_total (Results > Nodal displacement ) in the plate is examined then very large 
deformations seem to appear. This is especially the case at the location of the edges.  

 

This phenomenon can be ascribed to the fact that the plate has no rotational stiffness around the Z-axis. 
‘Energy less’ deformation occurs, which means that the plate does not know any resistance against the 
deformation φz. 

However, in the middle of the plate it is remarkable that this deformation will be much smaller. In fact, they 
are nearly equal to the deformations of the plates on which the dummy-members are fixed, which we will see 
in the next section. This means that an infinite rigidity is ascribed to the connection plate-column. You can 
verify this by comparing the deformation of this node in the plate with the deformation φz of the column: 
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Solution 

Dummy elements 

The top of the column must be connected to the plate with more than just a node. By applying small 
horizontal beams over the top of the column, it is possible to connect the edges of the finite plate elements to 
the top node of the column. 

 

Applying two crossing dummy-members at the connections is a way to get a correct approach of the reality. 
These are attached to the plate by means of internal edges. This way, the small beams will take the rotation 
of the plate on themselves, so the plate has a stiffness around the Z-axis. In this case, the large 
deformations at the edges will be gone.  

In the example, a variation of the length of the beams is applied to verify the influence on the deformations. 
With this you receive the following results with a constant mesh of 0.25 m:  

Length of dummy 
[m]  

nxy max 
 [kN/m]  

φz max  
[mrad]  

U_total  
[mm]  

0 57.54 -0.302 270.206 
0.05 145.75 -0.139 0.564 
0.1 27.35 -0.141 0.449 
0.15 23.24 -0.137 0.428 
0.2 13.35 -0.140 0.419 
0.25 10.80 -0.140 0.414 
0.35 6.21 -0.142 0.409 
0.5 3.55 -0.142 0.407 
0.75 1.80 -0.143 0.406 

1 1.77 -0.143 0.406 

Several conclusions can be drawn: 
• When applying members of a very short length, this will affect the rotation and deformation 

sufficiently . 
• Increasing the length of such a dummy-member will only have a small influence on the deformation 

and rotation. 
• nxy, on the other hand, is more influenced when increasing the length: the larger the beams, the 

smaller the shear stress in the plate. 
• The shear force varies little when a length of approximately half the section of the column is taken. 
• When using a length  of the same dimensions as the section of the column , plausible results can 

be expected.  
• The section of the beams has a significant influence on the shear stress: a greater section gives rise 

to a smaller shear stress and reverse. 
 Preparatory to an analysis, a width equal to the dimension of the column and a height equal 

to the thickness of the plate can be considered. 
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Mesh size 

Subsequently the size of the mesh is varied when using a constant length of the dummy-beams, namely 
0.25 m. The following results can be summarized in a table: 

Mesh Size  
[m]  

nxy max 
 [kN/m]  

φz max 
 [mrad]  

U_total  
[mm]  

1 4.13 -0.139 0.411 
0.5 7.65 -0.140 0.412 
0.25 10.80 -0.140 0.414 
0.125 15.05 -0.140 0.415 
0.1 14.44 -0.144 0.416 
0.05 26.20 -0.140 0.416 
0.025 39.58 -0.140 0.417 

 

Also the following conclusions can be drawn: 
• The deformation and rotation are only influenced by the size of the mesh to a very limited extent. 
• The shear stress is more influenced: it increases as the size of the mesh decreases. 
 Preparatory to an analysis. a mesh equal to the length of the beam or double of the length can be 
taken, depending on the thickness of the plate. 

Example: 06_02_Moment mz Walls.esa 

Model 

When two walls are connected with a beam, a similar phenomenon appears. A solution can also be found in 
this case by means of the application of dummy-members as in the following figure: 

 

Two walls with a dimension of 4x4 m are connected with each other by means of a beam with a length of 
4m. This member is loaded in the middle through a point force of 10 kN.  

Results 

When applying dummy-members with a variable length, the following results are obtained: 

Length 
dummy-beam 

[m] 

Field moment 
 Mz [kNm] 

Moment at the ends 
 Mz [kNm] 

φz 
[mrad] 

0 9.99 0 0.277 

0.2 6.41 -3.59 0.078 

0.4 6.20 -3.80 0.067 

1 6.18 -3.82 0.065 
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Even though the beam is fixed on both walls, it seems that this one has a moment of zero at the 
connections. In other words, it looks like there are hinged connections. When using dummy-beams, these 
moments rise slowly.  

The walls show a much lower resistance against rotation around the Z-axis when there are no dummy-
beams. This can be verified for the rotations φz. As in the previous example, there is a lack of rotational 
stiffness around the vertical axis.  

Also in this case it can be solved by applying little beams to take care of this rotational stiffness. This effect 
becomes clear when the deformation of the connecting beam is verified:  

 

In the top structure, there are no dummy-members. In this case, the beam has the largest deformation 
because there is no transition of the moment at the location of the connections. In the following structures, 
the rotational stiffness is taken on the dummy-members and the beams will bend less than in other cases. 
Because of this, the moments at the ends will differ from zero. This way there is a better approach of reality.  
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Chapter 7: Choice of the element size 

Introduction 
There are no general methods to define the element size that has to be used in the calculation of certain 
structures. However, there are some basic rules, which will be explained below: 

• a simple method to define the correct element size experimentally 
• experience of the calculation of practical examples with this element type 
• understanding into the singularities if the result does not converge to the sought solution. 

A refinement of the mesh does not offer any outcome in this case. 

With a lack of experience with similar structures the experimental procedure- as mentioned below- will be in 
most cases the only method to define the right element size: 
1. Calculate the structure with an element size L. 
2. Calculate the structure with an element size L/2. 

The element size can be altered for the entire structure or just around the location of the sought result. 
3. Compare the results and verify the differences (maximal field moment, maximal moment at the edges, 

maximal stress, theoretical needed reinforcement,…). 
If this result is larger than the intended accuracy, it will be necessary to continue to refine the mesh.  

The first rule for an initial choice of the element size exists of equating L with the thickness of the plate. 
Obviously, this is not applicable for thick plates. A second rule says that there has to be 5 to 10 elements per 
edge. 

As mentioned above the option ‘in nodes, no averaging’ gives a good indication of the accuracy of the used 
mesh.  

Further in this chapter, a few examples of ‘patch tests’ are given, in which the influence of the mesh 
refinement on the results can be verified. A finer mesh will lead to more accurate results but has a larger 
calculation time as a consequence. 

However, in some cases the results of the finite elements calculation does not converge to the expected 
result. In such cases an increased mesh refinement does not offer a good solution.  

Three examples of such singularities that occur in real terms are discussed in the paragraph “Singularities”. 
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7.1. Patch test plate – Comparison with beam elemen t 

Example: 07_01_Patchtest_1.esa 

Model 

A beam with rectangular section (width 1 m x height 0.3 m) is compared with a plate. The span is 8m, the 
beam is fixed at both sides and loaded with a line load of 100 kN/m. The material is C25/30 according to EC. 
The coefficient of Poisson is equal to 0 to eliminate the transverse deformation of the plate.  

Results 

The result of a beam calculation in SCIA Engineer is taken as reference. The reason for this is that SCIA 
Engineer takes the shear force deformation into account in the standard way.  

 

The results for the internal forces are claimed in nodes, avg. 

The maximal deformation U_total (reference result: 15.3 mm ): 

Element size 
[m]  

# elements 
along the length  

Uz 
[mm]  

2 4 -11.2 

1.3 6 -13.4 

1 8 -14.2 

0.8 10 -14.5 

0.4 20 -15.0 

0.2 40 -15.2 
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The maximal field moment mx (reference result: 266.67 kNm ): 

Element size 
[m]  

# elements 
along the length  

mx  
[kNm/m]  

2 4 268.52 

1.3 6 270.73 

1 8 268.71 

0.8 10 268.56 

0.4 20 266.12 

0.2 40 265.99 

 

The maximal moment at the ends (reference result: -533.33 kNm ): 

Element size  
[m]  

# elements along 
the length  

mx  
[kNm/m]  

2 4 -525.74 
1.3 6 -520.68 
1 8 -519.37 

0.8 10 -520.22 
0.4 20 -542.59 
0.2 40 -552.28 

 

Next, the results are grouped in a convergence curve:  

 

Conclusions: 
• The results converge to the exact solution 
• The field moment is always precise 

The moment at the edges (peak value) and the deformation require about 10 elements. 
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7.2. Patch test plate – comparison with analytic re sults 

Example: 07_02_Patchtest_2a.esa and 07_03_Patchtest _2b.esa 
The maximal deflection, the maximal field moment and the maximal moment at the edges of a plate fixed on 
the four edges are compared with analytic results. 

Model 

  

 

 

 

Length: a =5m 

Thickness: t = 0.02m 

Surface load: q = -10kN/m² 

Steel: S235 according to EC 

E = 210000 N/mm2 

ν = 0.3 

 

 

The plate is calculated in SCIA Engineer as well with Mindlin elements (Patchtest_2a) as Kirchhoff elements 
(Patchtest_2b). 

Reference 

S.P. Timoshenko and S. Wotnowsky-Krieger, Theory of Plates and Shells, 2nd edition, Mc Graw Hill, New 
York, 1987. 

Analytic results 

Deflection in the middle of the plate:  
f = 0.00126 q a4 / D. with D = E t3 / (12 ( 1 - ν2 ))   f = -51.187 mm  

Moment in the middle of an edge: 
M = 0.0513 q a2       M = 12.8825 kNm/m  

Moment in the middle of the plate: 
 M = 0.0231 q a2       M = 5.775 kNm/m 

 

a

a
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FEM Results 

The results for the internal forces are claimed in nodes, avg. The graph shows the Result / Reference result. 

The maximal deflection Uz in the middle of the plate (reference result: 51.187 mm ) 

 
# Elements  

 
Mindlin 
element 

 

 
Kirchhoff 
element 

 

4 -0.018 -63.477 

16 -49.221 -59.339 

25 -42.382 -49.184 

100 -51.039 -52.827 

400 -51.325 -51.764 

2500 -51.405 -51.462 

10000 -51.416 -51.418 

 
The maximal moment in the middle of an edge (reference result:  12.8825 kNm/m ) 

 
# Elements  

 
Mindlin 
element 

 

 
Kirchhoff 
element 

 

4 5.078 8.427 

16 11.791 10.753 

25 11.687 11.024 

100 12.999 12.787 

400 12.897 12.851 

2500 12.845 12.839 

10000 12.836 12.835 

 
The maximal moment mx in the middle of the plate (reference result: 5.775 kNm/m ) 

 
# Elements  

 
Mindlin 
element 

 

 
Kirchhoff 
element 

 

4 5.078 5.010 

16 6.675 6.452 

25 5.454 5.318 

100 5.855 5.820 

400 5.757 5.749 

2500 5.731 5.730 

10000 5.727 5.726 

Conclusions: 

• The results converge to an exact solution 
• 5 elements along the field give approaching values, 10 elements along the field give accurate values. 
• The Kirchhoff element in this case gives a slightly better approach than the Mindlin element. 

Reason: the reference result does not take the shear force deformation into account.

0

0.2

0.4

0.6

0.8

1

1.2

1.4

4 16 25 100 400 2500 10000

V
a

lu
e

/R
e

fe
re

n
ce

Uz - center of plate

Mindlin Kirchhoff

0

0.2

0.4

0.6

0.8

1

1.2

4 16 25 100 400 2500 10000

V
a

lu
e

/R
e

fe
re

n
ce

Mx - mid edge

Mindlin Kirchhoff

0

0.2

0.4

0.6

0.8

1

1.2

1.4

4 16 25 100 400 2500 10000

V
a

lu
e

/R
e

fe
re

n
ce

Mx - center of plate

Mindlin Kirchhoff



Advanced Concept Training – FEM Analysis  

60  TC – 2023/09/11 

Chapter 8: Singularities 

Equivalent plate ⇔ beam 
A frequently occurring misunderstanding is the fact that the user thinks that a simple plate supported on 2 
edges behaves as a beam. This is only the case without transverse contraction (if ν = 0). With normal values 
of the Poisson coefficient (ν = 0.2 or ν = 0.3) very high peaks of the reactions appear near the angles. 

Mesh refinement does not offer a satisfactory solution in this case and will even increase the peak value.  

This peak value is correct and converges to the theoretical value infinity by increasing the mesh refinement.  

This can be explained as follows. 

Consider the plate as different beams which lie next to each other. With ν = 0.2, the bottom of the beam 
becomes smaller, the top on the other hand becomes broader. The plate is going to bend in a direction 
parallel to the supported edges, with the round side upwards (saddle forming: the plate deforms in the 
bearing direction with the round side upwards). This bending is prevented by the line supports. 

In a continuous plate, this will cause bending moments My in the transverse direction, approximately with a 
size of 0.2 Mx. If this moment My occurred along the entire width of the plate, the reaction would be 
constant. However, the moment must be zero on the free edges. So, it seems that an opposite moment 0.2 
Mx exists on this edge, which leads to great reactions in the corners. In other words: at the end of the plate 
the saddle forming is not prevented any more by the moments in the plate. The plate wants to deform 
downwards at the end, which is prevented by the rigid supports. Because of this, very large reactions 
appear.  

Example: 08_01_Platebeam.esa 

Model 

In this example, a plate of 3 m x 10 m is calculated according to EC. The material is made of concrete 
C25/30. The thickness of the plate amounts to 200 mm. The plate is supported on the long edges and is 
loaded by a uniform load of 100 kN/m2. 

Without the plate action, a uniform line load of 150 kN/m is expected along each border.  

Results 

The plate is calculated with an increasingly finer mesh. The maximal reaction in the corner increases more 
and more: 
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Element size [m]  max. reaction rigid 
support [kN/m]  

max. Reaction flexible 
support [kN/m]  

Reduction peak 
value %  

0.8 185.42 179.07 3.4 

0.4 248.83 210.28 15.5 

0.2 342.28 227.07 33.7 

0.1 443.02 213.79 51.7 

0.05 541.19 232.85 57 

 
The peak in the reaction can be attributed to the infinite stiffness of the support. A realistic stiffness reduces 
the peak value considerably. 

In this example, the rigid supports are replaced by the stiffness of a concrete wall with E-modulus  
32.000 MPa, a thickness of 0,1 m and a height of 4 m. 
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The results clearly indicate that the flexible supports have a decreasing influence on the peak value. This 
effect is given in the following diagram: 

 

Free edge 
With a free edge, a 2D plate cannot satisfy all the boundary conditions when using Kirchhoff elements. This 
effect is not a property of certain elements or the finite element method, but of the simplifications of the plate 
theory.  

The explanation of this effect is explained in detail in reference [4]. 

The figure below shows the border of a plate that is free supported (hinged supports). In a section 
perpendicular to the support, a torsion moment mxy exists. The created shear stresses have to go round at 
the end of the plate, which occurs along a width equal to the thickness of the plate.  In this part of the plate 
the shear stresses produce a resulting vertical force V. 
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The dimension of the concentrated force V can be calculated by means of the part of the plate that is 
displayed in the following picture.  

 

In the sections parallel to the x-axis, a moment myx prevails and in the section parallel to the y-axis a moment 
mxy prevails. Then the couple equilibrium around the x-axis is considered. In this equilibrium mxy and the 
forces V play a role from which follows:  

V = mxy 

This is the case for a constant torsion moment. The vertical equilibrium of the forces with a varying torsion 
moment is drawn on the picture below. 

 

Over a distance dy, the concentrated vertical force has increased with the value dmxy/dy.  On the basis of the 
vertical force equilibrium, the following formula is now valid: 

r = vx + dmxy/dy 

r is also called the shear force of Kirchhoff. The word shear force is not correct, since r is a reaction force of 
the line support. 

Analogously, concerning the reaction of the edge parallel to the x-axis: 
r = vy + dmxy/dy 

The torsion moment is transformed under the form of additional reactions. Only the increase of the torsion 
moment seems to play an important role. 

This effect is known at the end of the edge, in the corner of the plate. On the picture below, the corner of a 
plate has been drawn in which two free supported edges come together. The dimension of the plate e is very 
small. On the two edges outside the plate, there is no possibility for the appearance of a vertical force with a 
value of mxy or myx. In the sections trough the plate, they may occur. To ensure the vertical load of this 
corner, there has to be a concentrated reaction with a value of mxy+myx. A familiar example is the rectangular 
plate with a surface load and supported on all the edges. In here, tensile forces occur in the corners.  

 

On the free edge the reaction equals zero: 
r = vx + dmxy/dy = 0 

This does not necessarily imply that vx or mxy equal 0. 
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Specifically, this means that when using the Kirchhoff elements in SCIA Engineer at a free edge, a torsion 
moment mxy may occur. 

When using Mindlin elements, there is an additional degree of freedom (rotation of the normal on the axis of 
the plate with regard to the plate axis in deformed state) and the condition of mxy = 0 can be met. There may 
occur a moment mxy in the plate and the gradient of mxy may give very huge shear forces because of the 
condition of the vertical equilibrium. These shear forces occur entirely in the first row of elements along the 
corner. With increasing mesh refinement this shear force converges to infinity. It can be neglected during the 
design. 

Example: 08_02_Free edge.esa 

Model 

In this example a plate of dimension 5 m x 5 m is calculated with concrete quality C25/30 according to the 
EC. The thickness of the plate is 0.2 m. The plate is hinged on two edges and loaded by a free surface load 
of -50 kN/m². 

The plate is calculated with different dimensions of the Finite Element mesh. The results for the torsion 
moment on the free edge and the shear force vx in a corner are claimed in nodes, averaging. 

 

Results 

Mindlin element: 

# Elements mxy edge  
[kNm/m]  

vx corner  
[kN/m]  

25 12.87 175.94 
100 15.45 242.78 
400 12.84 345.39 
1600 8.05 472.71 

2500 6.46 516.55 
10000 2.69 657.93 
40000 0.88 800.02 

 
Kirchhoff element: 

# Elements mxy edge  
[kNm/m]  

vx corner  
[kN/m]  

25 16.57 117.06 

100 19.39 114.15 

400 20.33 112.23 

1600 20.68 110.81 

2500 20.73 110.44 

10000 20.82 110.14 

40000 20.86 109.79 
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The results are shown in following convergence curves: 

 

 

The above-mentioned behavior of both elements is clearly noticeable: 

• for the Mindlin element: 
mxy converges to the correct value zero, and 
on the other hand, the shear forces increase.  

• for the Kirchhoff element: 
the condition mxy = 0 cannot be satisfied, even with a mesh refinement, and 
the shear force converges to a constant value.  
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Nodal support 
In most cases, a column or pole is introduced as a nodal support. The real dimensions of the support are 
neglected. In the Finite Element Method this is a singular node and the bending moment above this support 
is theoretically infinite. The moment will also converge to this infinite value with increasing mesh refinement.  

Refining of the mesh does not lead to the desired results in this case since the moment does not converge to 
the real value.  

A possibility to calculate this moment correctly is to introduce the column not as a nodal support but as a 
flexible supported sub region. The dimensions of the sub region are the dimensions of the column. The 
flexible support can be calculated out of the stiffness of the column. The results of such an approach are 
compared to the results of a nodal support in the example below. 

With an element mesh of half the dimension of the column, the model with a sub region gives a good value 
of the occurring moment. The value is a little bit higher than the real occurring moment. An even finer mesh 
gives unreal values. An element size equal to the dimension of the column is too coarse and gives an 
underestimation of the real occurring moment.  

Example: 08_03_Nodal support.esa 

Model 

In this example a floor is analyzed. It is supported by columns. The plate has a thickness of 0.2 m and is 
made of concrete C25/30 according to the EC. The whole floor is loaded with a surface load of 100 kN/m². 

For the calculation one field of 6 m x 6 m is considered. In the middle of this field a nodal support is inserted 
to represent the column. At the edges the rotation of the plate is prevented in both directions since the plate 
is stuck ‘on itself’. 

In the first case the column is introduced by means of a nodal support. Secondly, the column is made as a 
sub region supported by a flexible foundation. And in the last case, an averaging strip is used with the 
dimensions of the column.  

For the calculation of the stiffness a concrete column has been taken with a E modulus of 32.000 MPa, a 
height of 4m and a cross-section of 0.5m x 0.5m.  
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The structure is calculated with Mindlin elements. The results are claimed in  nodes, averaging.  

Element size [m]  
max. mx  

nodal support  
[kNm/m] 

max. mx 
elastic foundation  

[kNm/m] 

max. mx 
Averaging strip 

 [kNm/m] 
1 968.78 725.19 879.22 

0.5 1193.00 731.10 1015.01 

0.35 1594.68 737.66 847.04 

0.25 1421.61 671.41 1068.10 

0.125 1652.66 660.95 1071.67 

0.0625 1887.69 531.32 1077.35 

 
The results are shown in following convergence curve: 

 

Conclusion 

The results show the greatest peak value when the nodal support is used without an averaging strip. 

The moment is strongly reduced when a subregion has been used. 

The buffering effect of the subsoil on the result is clearly noticeable. 

From this, you can conclude that the subsoil will approach reality most accurately. 
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Chapter 9: Mindlin versus Kirchhoff 

Shear force deformation 
For the bending behaviour there are 2 types of elements implemented: 

• The Mindlin element including shear force deformation; 
• The Kirchhoff element without shear force deformation. 

With the Kirchhoff element a plane section of the plate remains perpendicular to the deformed axis of the 
plate in the deformed state. This traditional bending theory is applied for thin plates and is supported by 
following assumptions (ref. [8]): 

• The middle plane is free of strains and stresses; 
• The stress component perpendicular to the surface (σz) is negligible (σz ≅ 0); 
• A normal vector on the middle plane also remain perpendicular to the reference surface after the 

deformation (hypothesis of Bernoulli). 

For this theory the following conditions have to be satisfied:  
• The thickness t of the plate is small with regard to the span L (t/L < 1/5); 
• The deflections w remain small in comparison to the thickness of the plate t (w/t < 1/5). 

On the other hand, the Mindlin theory doesn’t have one of the above-mentioned assumptions, namely: the 
normals on the middle plane remain straight but not necessarily perpendicular to the middle plane after 
deformation. As a consequence, additional strains γxz and γyz arise in case of a Mindlin element.  

This is shown on the picture below.  

Figure a) represents the used symbols. 

Figure b) shows the Kirchhoff element. 

Figure c) the Mindlin element.  

On figure d) a Navier balk is demonstrated, which corresponds to the Kirchhoff element.  
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The choice between these two elements can be made using the menu function Tools > Calculation & mesh 
> Solver settings. By default the Mindlin theory is used and because of this, special attention should be paid 
to the use of thin plates. 

 

This option is only in relation with 2D elements. Specifically for beams, the shear force deformation can be 
taken into account or not by means of the option Neglect shear force deformation (Ay, Az >> A) .  

The influence of the shear force deformation is especially important with thick plates with a small span.  

Example:  09_01_Shear force deformation.esa 

Model 

In this example 3 plates of 2 m x 5 m, supported at the shortest edges and made of concrete C25/30 
according to EC, are calculated. The thickness is successively 300 mm, 600 mm and 1200 mm. A surface 
load of -150 kN/m2, -1200 kN/m2 and -9600 kN/m2 is applied. The mean dimension of the element is 0.5 m. 

 

Results 

The deflection in the middle of the plate:  

 Kirchhoff element Mindlin element % Difference 

Plate 300 mm -16.90 mm -16.91 mm 0.06 

Plate 600 mm idem -17.36 mm 2.65 

Plate 1200 mm idem -19.12 mm 11.61 
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Kirchhoff versus Mindlin on the edge of an element  
In the theory of Mindlin three degrees of freedom are available on the edge of a plate element: 

 

 

• w = deformation in the 
local z-direction of the plate 

• ϕ| | = rotation around ny  
(rotation parallel with the edge) 

• ϕ| = rotation around nx  
(rotation perpendicular on the edge) 

In Kirchhoff’s theory only two variables are needed:  the variable ϕ| | does not exist, 
because shear deformation is not taking into account in Kirchhoff’s theory.  

On the edge, the following forces will be taking into account for Kirchhoff and Mindlin: 

 

Kirchhoff Mindlin 

 

 

 

 

Kirchhoff assumes a constant torsional moment on the end of the plate.  

Mindlin assumes that the torsional moment mxy will become zero on the edge, but this results in high values 
for vx and vy. 

In Mindlin’s theory the torsional moment will go from its maximum to zero over a distance of t/2 (t = the plate 
thickness). For thin plates, this is a very small area, so when using Mindlin’s theory for thin plates a lot of 
finite elements will be necessary on the edges.  

This is shown in the following example. 
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Example:  13_01_Kirchhoff vs Mindlin.esa 

Model 

This next example shows two plates with a different thickness (200 mm and 2250 mm).  

The mesh of this plate is 0,5 m, but on the edges a denser mesh has been inserted: 

 

Results 

Thin plate: 

Element 
size edge 

[m]  

Uz 
[mm] 

Max |mxy| 
edge 

[kNm/m]  

Max |vx| 
edge 

[kN/m]  

Uz 
[mm] 

Max |mxy| 
edge 

[kNm/m]  

Max |vy| 
edge 

[kN/m]  

 Mindlin  Kirchhoff  

0.50 6.2817 9.62 90.83 6.2184 15.19 15.12 

0.25 6.3357 8.81 156.98 6.2173 15.00 17.38 

0.10 6.3400 7.13 253.29 6.2142 15.05 19.65 

0.05 6.3528 4.01 243.76 6.2140 15.05 19.96 

0.025 6.3572 1.50 247.36 6.2141 15.05 18.36 

0.01 6.3679 0.81 243.74 6.2141 15.05 20.05 
 
Uz 

The deformation Uz for Mindlin and Kirchhoff (in the middle of the plate) are similar and do not depend on 
the edge mesh size. 
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Mxy 

As explained before will Mindlin results in a zero mxy using small elements. The comparison between 
Mindlin and Kirchhoff is made in the diagram below: 

 

When inserting a lot of elements, Mindlin will get a very small mxy for thin plates. 
In this example a mesh of minimum 0.025m is needed. 
This is an unreasonable small mesh to calculate with. 

Vy 

The comparison between Mindlin and Kirchhoff is made in the diagram below: 

 

The small value for vy at Kirchhoff’s calculation is clearly noticeable, even with a small number of elements. 
But when using Mindlin, then vy will reach high values. 

In the case of thin plates, calculating with Kirchhoff is a better option, because Mindlin does not get 
satisfactory results, unless when inserting an unreasonable small mesh on the plate borders. 
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Thick plate: 

Element 
size edge 

[m]  

Uz 
[mm] 

Max |mxy| 
edge 

[kNm/m]  

Max |vx| 
edge 

[kN/m]  

Uz 
[mm] 

Max |mxy| 
edge 

[kNm/m]  

Max |vy| 
edge 

[kN/m]  

 Mindlin Kirchhoff 

0.50 0.0066 2.71 15.82 0.0044 15.19 15.12 

0.25 0.0066 1.71 20.69 0.0044 15.00 17.38 

0.10 0.0066 0.89 17.40 0.0044 15.01 19.65 

0.05 0.0066 0.36 17.07 0.0044 15.02 19.96 

0.025 0.0066 0.14 16.62 0.0044 15.05 18.36 

0.01 0.0066 0.08 16.52 0.0044 15.05 20.05 
 

  

Uz 

Deformations in the middle of the plate are different.  In the case of Mindlin the shear force deformation is 
taken into account, and this leads to more accurate results for thick plates. 

Mxy 

When the calculation is done with Mindlin for thick plates, mxy reaches low values, even with a small number 
of elements at the borders (a mesh of 0.5 m). 
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Vy 

In the case of thick plates, the values for vy are similar between Mindlin and Kirchhoff, and the values remain 
very small. 

 

So, for thick plates, calculating with Mindlin will give the best results, because shear force deformation will 
have more importance and mxy will go to zero, even for a small number of elements. 

Conclusion 

Thin plates 
• Calculating with Kirchhoff gives the best results for thin plates; 
• Using Mindlin dense mesh will be necessary on the edges to obtain good results; 
• Using Kirchhoff, the size of the elements does not have to be smaller than the plate thickness. 

Thick plates 
• Calculating an isotropic, homogeneous plate, Mindlin will be necessary; 
• On the edge, a denser mesh will be necessary (more than 5 elements over the half of the plate 

thickness); 
• Mindlin will also give reliable results for thin orthotropic plates with a small shear stiffness. 
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Chapter 10: Ribs 

Introduction 
By means of the menu Input Panel >  Structure > 2D Members > Ribbed slab a plate can be stiffened with 
members. 

A rib is calculated as a beam with eccentricity with regard to the axis of the plate. The member elements are 
connected to the plate at the height of the mesh nodes.  

In a 2D plate project, a rib can only be inputted in the middle of the plate. In a 3D General project, the rib can 
also be placed below or above the plate. After all, a rib that lies below or above the plate causes membrane 
forces in the plate. Membrane forces are not present in 2D plates, only in 3D shells. 

In SCIA Engineer a rib below a plate is always shear resistant connected to the plate. 

The total rigidity is according to the rule of Steiner: 
Rigidity beam + Rigidity plate + Surface beam x (axis-distance  beam-plate)² 

So, it is important to realize that also in reality the beam and the plate must be connected as shear resistant 
to each other. When analyzing a prefab construction where the plate is on top of the beam, then the beam 
should be placed in the middle of the plate in the calculation model. 

The collaborating width of the rib is calculated implicitly by the behavior of the finite elements under 
membrane forces during the Finite Elements Calculation.  In the following view of the membrane forces nx in 
the longitudinal direction of the beam, the effective width is clearly noticeable. 

 

The section of the rib can be shown graphically, in that way you can see if the effective widths overlap each 
other or not. 

This can be done by means of view parameters, namely ‘View settings for all entities > Structure > Draw 
cross-section’. 
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Replacement T-section 
What is explained in the previous paragraph is also valid for a member that is connected to an Internal edge  
of the plate and has been aligned eccentrically. The difference with a plate rib is that for a rib an Effective 
Width  can be inserted too.  

The Effective Width was specifically implemented to follow the code concerning the calculation of the 
theoretical reinforcement. Because when the option Rib  is marked with the results, a replacement T-section 
is used to calculate the results. The height of the T-section is determined by the height of the beam + the 
height of the plate. The flange width of the T-section equals the entered Effective Width.  

The internal forces for the replacement T-beam are calculated as follows: 

T the heart of the entire replacement T-section  

T1 the heart of the left part of the effective width  

T2 the heart of the right part of the effective width 

T3 the heart of the original rib 

 

The coordinates of the hearts are used as lever arms in the Y and Z direction: 

Lever arm Z1 = T1z – Tz Lever arm Y1 = T1y – Ty 

Lever arm Z2 = T2z – Tz Lever arm Y2 = T2y – Ty 

Lever arm Z3 = T3z – Tz Lever arm Y3 = T3y – Ty 

Lever arm Z = Tz – 0z Lever arm Y = Ty – 0y 

N = N beam + N plate, left + N plate, right 

Vy = Vy beam + Vy plate, left + Vy plate, right 

Vz = Vz beam + Vz plate, left + Vz plate, right 

Mx = Mx beam + Mx plate, left + Mx plate, right 

My = My beam + My plate, left + My plate, right + N plate, left * (Lever arm Z1)  
+ N plate, right * (Lever arm Z2) + N beam * (Lever arm Z3) 

Mz = Mz beam + Mz plate, left + Mz plate, right + N plate, left * (Lever arm Y1)  
+ N plate, right * (Lever arm Y2) + N beam * (Lever arm Y3) 

If the option Rib  is activated when visualizing the plate forces, then the internal forces in the cooperating 
width of the rib are set to zero. This counts for the internal forces in the longitudinal direction of the rib. The 
forces perpendicular to the rib remain unchanged. 

These internal forces can be set to zero for the reinforcement calculation because they are already 
considered in the reinforcement calculation of the rib. Thus, the whole plate-beam is replaced by a T-beam. 

However, note that when using several ribs below a plate element, the cooperating widths should not overlap 
each other. If this does happen, then the values of the internal forces are counted double on the areas of the 
overlapping parts. 
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Example: 10_01_RIB.esa 

Model 

In this example, a beam is calculated with a length of 10 m and concrete quality C25/30 according to EC. 
The beam is supported at the extremities, loaded with a distributed load of 200 kN/m and has following 
section: 

 

The beam is modeled in 3 separate ways: 
• As member element 
• As plate with a thickness of 200 mm with a rib of 200 mm x 400 mm below the plate 
• Entirely with Finite Elements 

 

The whole is calculated with an average element size of 0.1 m. The results are visualized in nodes, 
averaging on macro. 

Results 

 
 Beam Plate + Rib  Difference  

[%]  
Finite  

Elements  
Difference  

[%]  
Maximal bending in the middle [mm] 120.9 122.9 1.6 % 122.4 1.2 % 

Maximal moment in the middle [kNm] 2500 2499.86 0.0 % 2497.89 0.1 % 

Maximal shear force at the end [kN] 1000 1000 0.0 % 919.51 8.1 % 

 
The results indicate that the calculation model with rib and the Finite Elements model approach the beam 
well. With the Finite Elements model however, a higher deviation occurs concerning the shear force at the 
end, but when refining the mesh more, this difference becomes minimal. 

However, ribs that are modeled this way have a few restrictions. These are explained in the next paragraphs. 
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Boundary conditions 
As already said at the introduction of this chapter, membrane forces in the plane of the plate (compression 
forces in the field) arise because of the rib below the plate. The plate is here shorter in the longitudinal 
direction. 

The supports entered on a plate + rib are located at the axis height of the plate. This is not the axis of the T-
section formed by the plate and the beam. 

Concretely this means that if supports are input in the longitudinal direction of the plate, these supports will 
prevent the reduction of the plate. This leads to large reaction forces and a smaller bending since the rib will 
be more rigid. 

Example: 14_02_Boundary conditions.esa 

Model 

In this example, the same beam from the example 10_01_Rib.esa is considered. However, the plate with rib 
is now tied up to both ends in the X, Y and Z direction. 

Results 

 
 

 Beam Plate + 
Rib  

% 
Difference  

 Maximal bending in the middle [mm] 120.9 104,0 13.98 % 
 Maximal moment in the middle [kNm] 2500 2183.82 12.65 % 
 Maximal shear force at the end [kN] 1000 1000 0.00 % 

 
The effect on the bending mentioned above is clearly noticeable. The reduction of the field moment can be 
ascribed to the moment that occurs at the ends. This moment is caused by the eccentricity of the central axis 
of the T-section in relation to the support.  

The moment can be easily calculated: 

 The normal force in the T-section amounts to 3761.48 kN 

 The levers arm Z1 = 86 mm  

My = 3761.48 kN x 0.086 mm = 323.49 kNm  ≈ 316.18 kNm 
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Torsion 
The calculation of a rib as a beam with eccentricity regarding the plate provides less accurate results for 
torsion.  
The reason for this is that the torsional stiffness of the rectangular beam and the torsional stiffness of the 
plate added up do not give the torsional stiffness of the T-beam. 

Example: 10_03_Torsion.esa 

Model 

In this example, the same beam from the example 10_01_Rib.esa is considered. The beam is clamped at 
the beginning and is free at the end. The beam is loaded with a distributed torsional moment of 50 kN/m. 

To obtain an accurate reference result, the torsional moment of inertia of the T-section is calculated exactly 
by way of a Finite Elements calculation with element size 5 mm. 

 

Results 

 
 Beam Plate + 

Rib  
% 

Difference  
Finite Elements  % 

Difference
Maximal rotation Fix at the end 
[mrad] 

52.1 59.1 13.4 % 55.4 6.3 % 

 
The results show that the deviation is quite significant. 
If torsion is important, it is advisable to switch to a Finite Elements model. 
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Shear force deformation 
The shear force deformation in a beam is charged automatically in SCIA Engineer. The shear area Az is 
qualifying for the shear force deformation. This quantity is calculated accurately for the T-section.   

With a rib, Az is calculated for the rectangular cross-section. When using the Mindlin element, the shear 
force deformation of the plate is also taken along. The two separate calculations do not have the same result 
as a T-section. 

Shear force deformation only has an influence with high beams with short spans and here the influence 
remains restricted. This deviation is in most cases of less importance. 

Line support 
A plate with ribs is supported by those ribs at the height of the internal edge that connects both parts. 
However, the plate is supported over the width of the beam. 

This distinction gives a difference in the moments in the plate in the direction perpendicular to the rib. This 
should be considered with ribs that have a large width or with ribs that consist of a reversed U cross-section 
(as with a tubular bridge). 

Example:  10_04_Tubular bridge.esa 

Model 

In this example, the tubular bridge is modeled. The different elements have a thickness of 22 mm and are 
made from concrete C25/30 according to EC.  The bridge deck has a length of 20 m, a width of 5 m and is 
supported by 3 ribs with a height of 1 m and a width of 1m. The bridge is simply supported at both sides. On 
the bridge deck, a uniform distributed load of 50 kN/m² is applied. 

The whole is calculated with an average mesh size of 0.25 m. The results are visualized in nodes, avg. on 
macro in two sections in the middle of the bridge.  

Results 

 
 

 Finite Elements  Plate + Ribs  % Difference  
Maximal bending Uz in the longitudinal 
direction [mm] 

35.1 39.5 12.5 % 

Maximal longitudinal moment mx in the 
plate [kNm/m] 

20.0 24.5 22.5 % 

Maximal shear moment my in the plate 
[kNm/m] 

13,3 24.5 84.2 % 

In the Finite Elements model the supports are attached to the bridge deck at the correct position. With the 
model with ribs, the connection line is situated between rib and plate in the middle of the U-section, which 
does not correspond to the reality. 

The results clearly show that the bridge deck is better supported by the Finite Elements model, with lower 
shear moments as a result. In the model with ribs, the headway of the supports is much bigger with bigger 
shear moment as a result.  
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Chapter 11: Orthotropy 

Theory 
In a 3D model, the following components of deformations appear in each point (respectively the 
deformations according to the x-, y- and z-axes): 

u(x, y, z) 

v(x, y, z) 

w(x, y, z) 

From these deformations, the following strains can be calculated:  

ε = [εx, εy, εz, εxy, εxz, εyz]T 

εx = du/dx 

εy = dv/dy 

εz = dw/dz 

εxy = 1/2 γxy = 1/2 (dv/dx + du/dy) 

εxz = 1/2 γxz = 1/2 (du/dz + dw/dx) 

εyz = 1/2 γyz = 1/2 (dw/dy + dv/dz) 

The stresses in each point are: 

σ = [σx, σy, σz, σxy, σxz, σyz]T 

The stresses and strains are related to each other, in the simplest case this relation is linear (Hooke’s law): 

σ = D ε 

D is a 6x6 matrix. The connection between stresses and strains is not based on assumptions, but describes 
the real physical behavior of the material. For that reason, this matrix is called the “constitutive” matrix.  

With the reduction to a 2D plate, the stresses are replaced by internal forces s. These internal forces s are 
known as the results of SCIA Engineer: 

s = [smT, sbT] 

sm = [nx, ny, qxy]T for membrane forces 

sb = [mx, my, mxy, qx, qy]T for bending 

The components of the deformations that are used with a 2D plate are the deformation of the axis of the 
plate, the rotation on the x-axis and the rotation on the y-axis: 

w(x, y) = w(x, y, 0) 

φx(x, y) 

φy(x, y) 

With the Kirchhoff element, the normal on the plate axis remains perpendicular to the plate axis. 
So, there is a double connection between w and φ: 

φy = -dw/dx 

φx = dw/dy 

With the Mindlin element the shear force deformations γxz and γyz also occur: 

φy = -dw/dx + γxz 

φx = dw/dy + γyz  
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From these 3 components of the deformation the strain can be calculated in each point of the plate (with the 
usual assumption that an even cross-section remains plane). From this strain, the stress can be calculated in 
each point of the plate by means of the constitutive matrix. Through integration of these stresses over the 
thickness of the plate, the internal forces that belong to the deformation can be calculated (for the full 
calculation, you can refer to ref. [2]). 

This gives the following connection for the membrane forces and deformations in the plane: 
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For bending components and deformations from the plane: 
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The Caracter ‘ means the derivative to x, while • means the derivative to y.  ϕ'y en -ϕ•
x are curves. 

In most textbooks, the shear force deformation is neglected. Then: 

ϕ'y = -d2w/dx2 = curve κxx 

-ϕ•
x = -d2w/dy2 = curve κyy 

ϕ•
y  - ϕ'x = -d2w/dxdy -d2w/dxdy = -2 d2w/dxdy = curve 2 κxy 

The matrix for the bending effects is subsequently written as: 
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By dividing the membrane force components and the bending components, it is implicitly assumed that these 
components do not mutually influence each other.  

These stiffness matrixes do not only describe the physical behavior of the material, but also the stiffness of a 
plate element. This is specified by the material, possibly different materials over the thickness (reinforced 
concrete, laminated plates) and by the geometry (ribs, …). 
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In SCIA Engineer the following components are entered in this matrix: 
d11, d22, d33 and d 12 

D11, D22, D33, D44, D55, D12 

D44 and D55 are added because Mindlin elements with shear force deformations are used. In many cases 
there are no simple formulas to calculate these stiffnesses. 

The orthotropic parameters can be calculated by means of following formulas: 

for plate elements :  

 

D55 
G78 ∙ h

1.2  

D;; = G18 ∙ h
1.2  

G13 and G23 are used for the calculation of the stiffnesses D44 and D55. These are the stiffnesses for shear 
force deformation. In some cases, they cannot be calculated exactly. In that case it is advised to enter D44 
and D55 much larger (1000 times larger) than the other stiffnesses.  

In this way, you will neglect the shear force deformation. The influence of the shear force deformation is 
restricted with normal plate thicknesses/stresses. 

The best method to have a better approach for G13 and G23 is to calculate them with following formulas: 

    

for “wall” elements: 

 

Shell elements have both characteristics of a plate element as from a “wall” element. That way all physical 
constants, as described above, need to be applied.  

A real example is the use of floor plates that wear out in only one direction. With this, you can use orthotropic 
parameters. In the two directions, several stiffnesses need to be applied, to which you can attribute a quasi-
neglected stiffness to the shear direction.  

Another method to model this real example can be done as follows: you reduce the measurements of the 
plate a bit so they just fail to hit the non-supporting beams. What’s more, you attribute a Poisson coefficient 
of 0 to the plate material.  

A plate that is respectively torn and not torn in the X and the Y direction can also be modeled as a plate with 
orthotropic parameters. This way a different E-module can be applied in both directions. 
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Orthotropic parameters: isotropic plate 
The stiffness of an isotropic plate is entirely defined by the following parameters: 

E (modulus of elasticity), ν (Poisson coefficient) and h (thickness) 

For the membrane effects in an isotropic plate, the following formulas are applied: 
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By integration over the thickness, nx, ny en qxy are obtained in function of εx, εy and γxy, and so d11, d22, d33 
and d12: 
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For bending: 
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For a constant course of the shear stress τxz , τyz  over the height h, then β = 1.  From the analogy with a 
rectangular cross-section follows the assumption that from a parabolic stress course, we get coefficient β = 
1,2. 

Example: 11_01_Isotropic.esa 

In this example, the stiffness parameters are calculated for an isotropic plate. These stiffnesses are applied 
as an orthotropy on another identical plate, and the results are compared between the isotropic and 
orthotropic plate 

Project data 

  

 

 

Length: a = 10m 

Thickness: h = 400mm 

Distributed load: q = -10 kN/m2 

Concrete:  C25/30 according to EC 

E = 31500 N/mm2 

ν = 0,2 

 

Reference 

S.P. Timoshenko and S. Wotnowsky-Krieger, Theory of Plates and Shells, 2nd edition, Mc Graw Hill, New 
York, 1987. 
  

a

a
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Calculation of Stiffness parameters 

D11 = D22 = E h3 / (12 (1-ν2)) = 31500 x 4003 / (12 x (1 – 0.22)) = 1.75 E+11 Nmm = 175 MNm 

D12 = D21 = ν D11 = … = 35 MNm 

D33 = E h3 / (24 (1+ν)) = … = 70 MNm 

G = E / ((2 (1+ ν)) = … = 13125 MPa 

D44 = D55 = G h / 1.2 = … = 4375 MN/m 

Model 

The plate is simply supported on four sides and calculated with an average element size of 1 m without 
averaging strips on the edges. 

Results 

 

The results are claimed in nodes, avg.  for a section in the middle of the plate. 

 Isotropic  Orthotropic % Difference 
Deformation Uz [mm] -2.403 -2.403 0.00 % 
Moment mx [kNm/m] 45.20 45.19 0.02 % 

Conclusion 

The behaviour of both plates is identical, which proves that the stiffnesses are correctly calculated for an 
isotropic plate. 
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Orthotropic parameters: Practical cases 
In the literature, there are numerous examples available for the calculation of these coefficients in practical 
cases. In this paragraph, a few specific cases are explained. For more information see ref. [1]. 

Example: 11_02_Floorwithribsa.esa and 11_02_Floorwi thribsb.esa  

In this example, a floor with ribs is modelled. The plate has a thickness of 200 mm and dimensions of 10 m 
by 6 m. In the longitudinal direction, the plate is stiffened with ribs of 400 mm height and 200 mm width.  

The headway of the ribs is 2 m. The whole is made of concrete C25/30 according to EC. The floor is loaded 
with a consistent distributed load of 5 kN/m². 

Project data 

 
h = 200 mm  t = 200 mm 
 
a1 = 2000 mm  H = 600 mm 

Calculation of stiffness parameters 
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 ='
xyD torsional stiffness of the plate without rib 

 Az = shear area. T-section with width a1 
 C = torsional stiffness one rib = G * It 
 α = h / H 
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To calculate I, Az and It exactly, a Finite Elements calculation is performed of such a T-section with element 
size of 5 mm. 

 

From this follows: Iy = 8400000000 mm4    Material: C25/30 

   Az = 165280 mm²   => E = 31500 N/mm² 

It = 6322900000 mm4    ν = 0,2   

C = G * It = 8,2988 e13 Nmm²   G = 13125 N/mm² 

The formulae can now be filled in. According to the figure, the Y-axis lies in the longitudinal direction of the 
ribs. The ribs are entered in SCIA Engineer according to the X-axis. Specifically, this means that the formula 
for Dy matches in this case with D11.  

<77 = <� = 31500 ∗ 8400000000

2000
 132,2 ��� 

( )( ) MNmNmmDD x 5,2202250000000
200*600/200200200012

200*2000*30500
3

3

22 ==
+−

==  

MNmDD 0112 == ; in SCIA ENGINEER a very small value is entered. 

( ) MNmNmm
e

DD xy 61,366,53661398022
2000*2

8678,7
2,0112

200*30500 133

33 ==+
+

==
 

m
MN

mm
ND 76,107954,1079763

2000

169930*33,12708
44 ===  

m
MN

mm
ND 06,211856,2118055

2,1

200*33,12708
55 ===  

Model 

The floor with ribs is entered is SCIA Engineer in two ways: as orthotropic plate (Floorwithribsa) and as a 
plate with ribs (Floorwithribsb). The whole is calculated with the average element size of 0.25 m without 
averaging strips. 
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Results 

Maximal displacement Uz in a section in the middle of the plate: 

Orthotropic plate: -4.946 mm  

Plate with ribs: -4.952 mm  

Moment Mx in a section in the middle of an orthotropic plate, claimed in nodes, averaging : 

Mx = 62,51 kNm/m, over a cooperative width of 2m gives this: 125.02 kNm  

Moment My in the middle rib of the plate with ribs:  

My = 122.90 kNm 

Conclusion 

The moment Mx in the orthotropic plate is close to the moment My in the middle rib of the plate with ribs, and 
the displacement is very similar in both examples. 

The results show that the orthotropic parameters describe the behaviour of this stiffened plate well. 
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Example: 11_03_Grid.esa 

In this example, a grid is modeled. The frame consists of steel IPE 200 profiles and has dimensions of 14 m 
by 14 m. The headway between the beam amounts to 1 m in both directions. The whole is made of S235 
according to EC and is loaded with a surface load of 1 kN/m². 

Project Data 

 

 

 

 

 

a = 14000 mm 

a1 = 1000 mm 

b = 14000 mm 

b1 = 1000 mm 

Calculation of stiffness parameters 

1
* 11

b

IE
Dx =  

1
* 22

a

IE
Dy =  

01 =D  








 +=
114

1 21

a

C

b

C
Dxy  

with: 
 E1 = E2 = 210000 N/mm² 
 I1 = I2 = 19430000 mm4  
 C1 = C2 = G * It = 5637692254 Nmm² 
 G = 80769,23 N/mm² 
 It =69800 mm4 

From this follows: 

MNmNmmDD x 0803,44080300000
1000

19430000*210000
11 ====  

MNmNmmDD y 0803,44080300000
1000

19430000*210000
22 ====  

MNmNmmDD xy 002819,015,2818846
1000

69800* 80769,23
1000

69800* 80769,23
4
1

33 ==






 +==  

MNmDD 0112 == ; in SCIA Engineer a very small value is entered for this. 

For D44 and D55 no formulae are shown, so large values of this can be entered to neglect the effect of the 
shear force deformation.  
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Model 

The grid is entered in SCIA Engineer in two ways: as an orthotropic plate and as a real grid. The whole is 
calculated with the average element size of 1 m without averaging strips. 

Results 

Uz 

Maximal deflection Uz in a section in the middle of the orthotropic plate: -77.651 mm . 

Deflection Uz in the middle of beam B8: -77.042mm. 

Moments 

Moment Mx in a section in the middle of the orthotropic plate, claimed in nodes, avg.:  15.05 kNm/m .  

Moment My in the middle of beam B8: 15.05 kNm. 

Conclusion 

Also here the results show that the behavior of grid is very good approachable through a 2D element with 
orthotropic properties. 
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Orthotropic parameters: predefined cases in SCIA En gineer 
In SCIA Engineer there are different standard Types of orthotropy implemented. 

 

Standard 

This is the standard case of orthotropy where you have access to all available orthotropy parameters. 

You must input all parameters yourself: D11, D22, D12, D33, D44, D55, d11, d22, d12 and d33. 

 

When you change the “Thickness of the Plate/Wall” or the “Material”, then values are inserted in the 
orthotropy parameters D11, D22, … These are the values for a standard isotropic plate with this thickness 
and this material. 
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Two heights 

Simulation of a slab with a different thickness in local x and local y direction. 

 

 

You have to input the effective heights and reduction coefficients: 
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All orthotropic parameters are calculated: 

<77 = +. ℎ7812. #1 − >1$ 

<11 = +. ℎ1812. #1 − >1$ 

<71 = >. ?<77. <11 

<88 = @A7. #1 − >$. ?<77. <112  

<55 = B. ℎ7C  

<;; = B. ℎ1C  

With: 
• @A7 = DEFGHEI F�JKLDHEI LE�MM. 
• C = Gℎ�NF F�JKLDHEI LE�MM. 

J77 = +. ℎ.#1 − >1$ 

J11 = +. ℎ�#1 − >1$ 

J71 = >. ?J77. J11 

J88 = @A1. #1 − >$. ?J77. J112  

With: 
• @A1 = Gℎ�NF F�JKLDHEI LE�MM. 

Value β = 1.2 (for rectangular sections); also value 1.0 can be used. 

Value γf1: when setting this value to zero, then you get a ‘torsion weak’ plate, thus avoiding the lifting of the 
corner nodes. To get a numerically stable solution, use small values (0.05) instead of zero. 

Value γf2: when setting this value to zero, then you get a ‘shear weak’ wall, thus avoiding horizontal (shear) 
stiffening of the construction. To get a numerically stable solution, use small values (0.05) instead of zero. 
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One direction slab 

Simulation of a slab which carries it’s load mainly in one direction: 

 
 

The rigidity in the main direction is calculated based upon the properties of a user defined cross-section. You 
have to define the cross-section (CSS) of these unidirectional prefab elements and then use this CSS to 
define the orthotropy. 

Besides the CSS, you have to input the height of the topping h and the distance between the elements a1: 
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All orthotropic parameters are calculated: 

<77 = +7. *7N7  

<11 = +1. ℎ8
12  

<71 = 0 

<88 = OB7. *D7N7 P + QB1. ℎ8
3 R

8  

<55 = B7. S)7N7  

<;; = B1. ℎ
1.2  

 

J77 = +1. ℎ.#1 − >1$ 

J11 = +1. ℎ�#1 − >1$ 

J71 = >. ?J77. J11 

J88 = #1 − >$. ?J77. J112  
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Slab with ribs – rib inputted by the user 

Simulation of a slab with ribs in one direction: 

 

You have to input the rib dimensions, rib spacing and slab height: 
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All orthotropic parameters are calculated: 

<77 = +. *
N1  

<11 = +. N1. ℎ8

12. T#N1 − D$ + UOℎVP8 . DWX
 

<71 = 0 

<88 = +. ℎ8
12. #1 + >$ + B. *D

2. N1 

<55 = B. S)
N7  

<;; = B. ℎ
1.2  

 

J77 = +.. ℎ.#1 − >1$ 

J11 = +�. ℎ�#1 − >1$ 

J71 = 0 

J88 = #1 − >$. ?J77. J112  

 

With: 
o E : Young modulus of the material 
o I : moment of inertia of a T section of width a1 
o Az : Effective surface for shear of a T section of width a1 
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Slab with ribs – rib selected from the cross-sectio n library 

Simulation of a slab with ribs in one direction: 

 

You have to select the rib from the library and input the rib spacing and slab height: 
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All orthotropic parameters are calculated: 

If E1 > E2 

<77 = +1. * �,Y�� + +1. * �,��-ZN7  

If E1 < E2 

<77 = +7. * �,Y�� + +7. * �,��-ZN7  

<11 = +1. ℎ8
12  

<71 = 0 

<88 = ?<77. <112  

<55 = B7. S)7N7  

<;; = B1. ℎ
1.2  

 

J77 = +.. ℎ.#1 − >1$ 

J11 = +�. ℎ�#1 − >1$ 

J71 = 0 

J88 = #1 − >$. ?J77. J112  

 

With: 
• index 1 - Cross-section properties 
• index 2 - Slab properties 
• Iy,css – Moment of inertia of the cross-section with regards to the center of gravity of the equivalent 

T section 
• Iy,slab – Moment of inertia of the slab with regards to the center of gravity of the equivalent T 

section 
• following properties are taken from Cross-section and Material: 

o E modulus Ei 
o Effective surface for shear Az1 
o G modulus Gi 

 
  



Advanced Concept Training – FEM Analysis  

100  TC – 2023/09/11 

Grid work – ribs inputted by the user 

Simulation of a slab with ribs in local x- and local y-direction: 

 

 

You have to input the rib dimensions, rib spacing and slab height: 
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All orthotropic parameters are calculated: 

<77 = +7. *7N7  

<11 = +1. *1N1  

<71 = 0 

<88 = OB7. *D7N7 P + OB1. *D1N1 P
4  

<55 = B7. S)1
N1  

<;; = B1. S)2
N7  

 

J77 = +.. ℎ.#1 − >1$ 

J11 = +�. ℎ�#1 − >1$ 

J71 = 0 

J88 = #1 − >$. ?J77. J112  
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Grid work – ribs selected from the cross-section li brary 

Simulation of a slab with ribs in local x and local y direction: 

 

 

You have to select the ribs from the library and input the rib spacings and slab height: 
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All orthotropic parameters are calculated: 

<77 = +7. *7[1  

<11 = +1. *1N1  

<71 = 0 

<88 = OB7. *D7[1 P + OB1. *D1N1 P
4  

<55 = B. S)1
[1  

<;; = B. S)2
N1  

 

J77 = +.. ℎ.#1 − >1$ 

J11 = +�. ℎ�#1 − >1$ 

J71 = 0 

J88 = #1 − >$. ?J77. J112  

 

With: 
• following properties are taken from Cross-section and Material: 

o E modulus Ei 
o Moment of inertia Ii 
o Torsion moment of inertia Iti 
o Effective surface for shear Azi 
o G modulus Gi 
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Masonry 

This orthotropy type is used as a simulation of a masonry wall. 

The orthotropic behaviour "Masonry" is basically the same as orthotropic behaviour “Standard” 

The difference is in the new parameter "Coeff. off reduction for arching effect". Parameter "d33" of standard 
orthotropy is multiplied with this coefficient. 

 

By this coefficient, it is easy to reduce arching effect in masonry wall. Default value is set on 0,01. Range can 
be <1 ; 0,0001 >. 

 

This type of orthotropy is automatically set when "Masonry Wall" is used in the project. 

A smaller value for the shear stiffness reducing coefficient means a smaller horizontal load carrying capacity 
of the wall. 
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Cross-Laminated timber 

The orthotropy type "Cross Laminated Timber" is used for 2D structures made out of timber in which the 
stiffness is calculated based on the composition of the different cross laminated timber layers. 

 

You have to select the number of layers, their thickness and the width of the lamella in directions x and y: 
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Flexural orthotropy 

 

Membrane orthotropy 

 
 
Notes:  

• In the Wall model the membrane stiffnesses (4 parameters) play the role of the flexural ones in the 
Plate model. The most general Shell model defines both parameter sets simultaneously (in total 10 
orthotropy parameters). 

• It is important to emphasize that within the solver settings the Mindlin bending theory should be 
used in combination with Cross-laminated orthotropy. 
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Parameters 

Symbols in formulae (1) – (10) 
 

 

Torsion reduction coefficient ktors 
The torsion reduction coefficient is used for determining the torsion stiffness D33. According to the research 
done by Silly, 2010 a value of 0.80 is recommended for CLT-panels without any cracks. Considering cracks 
a value of 0.65 is recommended. The coefficient can also be calculated according to ÖNORM B 1995-1-1 
(NA.K.2) in which the following equation is used: 

 
With 

, with ax and ay the individual lamination widths for the given direction 

dmax: Thickness of the thickest individual layer 

 3 layers  5 layers  7+ layers  

pD 0.89 0.67 0.55 

qD 1.33 1.26 1.23 

Shear stiffness coefficient kshear 
The shear stiffness coefficient which is used for determining the shear membrane stiffness d33. According to 
Silly (2010) when stressing a plate, the shear stiffness of cross-laminated timber must be reduced compared 
to homogeneous materials. A value of 0.75 is a good approximation for the shear stiffness coefficient. 

 

The coefficient can also be calculated according to ÖNORM B 1995-1-1 (NA.K.1) in which the following 
equation is used: 
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With: 

, with ax and ay the individual lamination widths for the given direction 

dmax: Thickness of the thickest individual layer 

 3 layers  5, 7+ layers  

pS 0.53 0.43 

qS 1.21 

Shear correction coefficients k0,z and k90,z 

The shear correction coefficients k0,z and k90,z are used to properly take into account shear deformations 
within the Reissner-Mindlin model. These shear correction coefficients have been investigated by Jöbstl for 
CLT-elements in Schickhofer et al., 2010. Within that paper multiple CLT-panels with constant thickness 
were tested and the outcome is summarized by means of shear correction factors kappa: 

 

 

In tabular form the following recommended values for kappa are [Cross-Laminated Timber Structural Design 
Volume 2, pro:Holz, 2018]: 

 1 layer  2 layers  5 layers  7 layers  9 layers  

Shear correction coefficient 
(25% quantities)  0.833 0.196 0.231 0.245 0.250 

Keep in mind that the above table describes the kappa-values which is the shear correction factor, while the 
orthotropy dialog expects the shear correction coefficients as input which is 1/kappa. 

The shear correction coefficient can also be calculated automatically, in the background the CLT-panel is taken 
as a cross-section with 1 m width. Afterwards its shear area Az is calculated per direction. Finally the shear 
correction factor kappa is obtained as the ratio between the shear area and the total area from which the shear 
correction coefficient can be derived as 1/kappa. 
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Chapter 12: Property modifiers 
In order to use property modifiers, this functionality should be activated in the project settings. 

 

Property modifiers are used to change the stiffnesses of both 1D and/or 2D elements. 

They exist as additional data that can be inputted on 1D and/or 2D members. 

Example: 12_01_Property modifiers.esa 

 

The advantage of property modifiers is that they are easy to apply and it is easy to understand how it works. 

A lot of practical applications can be considered. 

For example, the calculation of a concrete member that is assumed to be cracked. 
By using property modifiers here, you can keep on performing a linear calculation. 
In this way, a more complex PNL (physical nonlinear) or CDD (code dependent deflection) analysis is 
avoided. 





Chapter 13: Compression-only 2D members 

TC – 2023/09/11  111 

Chapter 13: Compression-only 2D members 
When using pressure 2D elements, the functionality Nonlinearity  and Compression-only 2D members 
must be activated in the project settings. 

 

With this option, tension in 2D elements can be automatically eliminated. This is mostly used for masonry 
elements. In below some examples to clarify this option. 

Example: 13_01_Pressure only1.esa 

This project illustrates the use of compression_only 2D elements. 

Model 

In this project two 2D-elements are modelled. The first one is modelled as an isotropic element, the second 
one is a pressure only element: 

   

When calculating those elements, for every mesh element a certain orthotropy will be inserted. At the first 
iteration step, all the pressure only elements will be calculated as isotropic elements. After the first 
calculation, another stiffness will be inserted on all the elements in tension, so a certain orthotropy will be 
inserted. With this stiffness, the tension capacity of this element will decrease. After adapting the orthotropic 
parameters, a new calculation will be performed. After this second iteration step, again the elements in 
tension will get another stiffness. This process will be repeated until an equilibrium is reached. 
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Results 

The difference between the isotropic and orthotropic elements can be clearly viewed looking at the principal 
normal force n1 for these members, which are obtained in centres and for nonlinear combination NC1: 

 

The results n1 show the ‘biggest’ principal normal force (since n1 > n2).  So, it is clear now that the right 
element only gets compression forces. 

Looking at the trajectories (by checking “trajectories” in the 2D internal forces menu) of this normal force, the 
trajectory of the pressure force will be even more visible: 

Trajectories for n1 

 

Trajectories for n2 
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Also for the beam above the opening, there is a difference for the moment My: 

 

  



Advanced Concept Training – FEM Analysis  

114  TC – 2023/09/11 

Example: 13_02_PressureOnly2.esa 

When looking at the pressure diagonals in a reinforced 2D concrete element, ribs can be used to simulate 
reinforcement.  

Model 

In this example, a plate with a bearing support is inserted with two ribs acting as the reinforcement of the 
element: 

 

Results 

Looking at the results of this 2D element, the pressure diagonals inside this element are clearly visible: 
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